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This document describes the R&S®SGU100A, stock no. 1418.2005.02 and its
options.

The firmware of the instrument makes use of the operating system LINUX® and other valuable open
source software packages. For information, see the "Open Source Acknowledgement" on the user docu-
mentation CD-ROM (included in delivery).
Rohde & Schwarz would like to thank the open source community for their valuable contribution to embed-
ded computing.
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Trade names are trademarks of the owners.

The following abbreviations are used throughout this manual: R&S®SGU100A is abbreviated as
R&S SGU, R&S®SGS100A is abbreviated as R&S SGS, R&S®SGMA-GUI is abbreviated as R&S SGMA-
GUI.
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Basic Safety Instructions 

All plants and locations of the Rohde & Schwarz group of companies make every 

effort to keep the safety standards of our products up to date and to offer our 

customers the highest possible degree of safety. Our products and the auxiliary 

equipment they require are designed, built and tested in accordance with the 

safety standards that apply in each case. Compliance with these standards is 

continuously monitored by our quality assurance system. The product described 

here has been designed, built and tested in accordance with the EC Certificate of 

Conformity and has left the manufacturer’s plant in a condition fully complying 

with safety standards. To maintain this condition and to ensure safe operation, 

you must observe all instructions and warnings provided in this manual. If you 

have any questions regarding these safety instructions, the Rohde & Schwarz 

group of companies will be happy to answer them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. 

This product is designed for use solely in industrial and laboratory environments 

or, if expressly permitted, also in the field and must not be used in any way that 

may cause personal injury or property damage. You are responsible if the product 

is used for any purpose other than its designated purpose or in disregard of the 

manufacturer's instructions. The manufacturer shall assume no responsibility for 

such use of the product.  

The product is used for its designated purpose if it is used in accordance with its 

product documentation and within its performance limits (see data sheet, 

documentation, the following safety instructions). Using the product requires 

technical skills and, in some cases, a basic knowledge of English. It is therefore 

essential that only skilled and specialized staff or thoroughly trained personnel 

with the required skills be allowed to use the product. If personal safety gear is 

required for using Rohde & Schwarz products, this will be indicated at the 

appropriate place in the product documentation. Keep the basic safety 

instructions and the product documentation in a safe place and pass them on to 

the subsequent users. 
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Observing the safety instructions will help prevent personal injury or damage of 

any kind caused by dangerous situations. Therefore, carefully read through and 

adhere to the following safety instructions before and when using the product. It is 

also absolutely essential to observe the additional safety instructions on personal 

safety, for example, that appear in relevant parts of the product documentation. In 

these safety instructions, the word "product" refers to all merchandise sold and 

distributed by the Rohde & Schwarz group of companies, including instruments, 

systems and all accessories. For product-specific information, see the data sheet 

and the product documentation. 

Safety labels on products 

The following safety labels are used on products to warn against risks and 

dangers. 

Symbol Meaning Symbol Meaning 

 

Notice, general danger location 

Observe product documentation 

    ON/OFF  Power  

 

Caution when handling heavy 
equipment  

Standby indication 

 

Danger of electric shock  Direct current (DC) 

 

Caution ! Hot surface  Alternating current (AC) 

 

Protective conductor terminal  
To identify any terminal which is 
intended for connection to an 
external conductor for protection 
against electric shock  in case of a 
fault, or the terminal of a 
protective earth 

 Direct/alternating current (DC/AC) 

 

Earth (Ground) 

 
 

Class II Equipment 
to identify equipment  meeting the 
safety requirements specified for 
Class II equipment 
(device protected by double or 
reinforced insulation) 

 

Frame or chassis Ground terminal 

 

EU labeling for batteries and 
accumulators. For additional 
information, see section "Waste 
disposal/Environmental 
protection", item 1. 
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Symbol Meaning Symbol Meaning 

 

Be careful when handling 
electrostatic sensitive devices 

 

EU labeling for separate collection 
of electrical and electronic devices 

For additional information, see 
section "Waste 
disposal/Environmental 
protection", item 2. 

 

Warning! Laser radiation 

For additional information, see 
section "Operation", item 7. 

  

 

Signal words and their meaning 

The following signal words are used in the product documentation in order to 

warn the reader about risks and dangers. 

 

Indicates a hazardous situation which, if not avoided, will 

result in death or serious injury. 

 

Indicates a hazardous situation which, if not avoided, could 

result in death or serious injury. 

 

Indicates a hazardous situation which, if not avoided, could 

result in minor or moderate injury. 

 

Indicates information considered important, but not hazard-

related, e.g. messages relating to property damage. 

In the product documentation, the word ATTENTION is 

used synonymously. 

These signal words are in accordance with the standard definition for civil 

applications in the European Economic Area. Definitions that deviate from the 

standard definition may also exist in other economic areas or military applications. 

It is therefore essential to make sure that the signal words described here are 

always used only in connection with the related product documentation and the 

related product. The use of signal words in connection with unrelated products or 

documentation can result in misinterpretation and in personal injury or material 

damage. 
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Operating states and operating positions 

The product may be operated only under the operating conditions and in the 

positions specified by the manufacturer, without the product's ventilation being 

obstructed. If the manufacturer's specifications are not observed, this can result in 

electric shock, fire and/or serious personal injury or death. Applicable local or 

national safety regulations and rules for the prevention of accidents must be 

observed in all work performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & 

Schwarz products:  

predefined operating position is always with the housing floor facing down, IP 

protection 2X, use only indoors, max. operating altitude 2000 m above sea 

level, max. transport altitude 4500 m above sea level. A tolerance of ±10 % 

shall apply to the nominal voltage and ±5 % to the nominal frequency, 

overvoltage category 2, pollution degree 2. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for 

reasons of weight or stability are unsuitable for this purpose. Always follow the 

manufacturer's installation instructions when installing the product and 

fastening it to objects or structures (e.g. walls and shelves). An installation that 

is not carried out as described in the product documentation could result in 

personal injury or even death. 

3. Do not place the product on heat-generating devices such as radiators or fan 

heaters. The ambient temperature must not exceed the maximum temperature 

specified in the product documentation or in the data sheet. Product 

overheating can cause electric shock, fire and/or serious personal injury or 

even death. 

Electrical safety 

If the information on electrical safety is not observed either at all or to the extent 

necessary, electric shock, fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage 

setting on the product matches the nominal voltage of the mains-supply 

network. If a different voltage is to be set, the power fuse of the product may 

have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and 

connector, operation is permitted only on sockets with a protective conductor 

contact and protective conductor. 
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3. Intentionally breaking the protective conductor either in the feed line or in the 

product itself is not permitted. Doing so can result in the danger of an electric 

shock from the product. If extension cords or connector strips are 

implemented, they must be checked on a regular basis to ensure that they are 

safe to use. 

4. If there is no power switch for disconnecting the product from the mains, or if 

the power switch is not suitable for this purpose, use the plug of the 

connecting cable to disconnect the product from the mains. In such cases, 

always ensure that the power plug is easily reachable and accessible at all 

times. For example, if the power plug is the disconnecting device, the length of 

the connecting cable must not exceed 3 m. Functional or electronic switches 

are not suitable for providing disconnection from the AC supply network. If 

products without power switches are integrated into racks or systems, the 

disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cables 

on a regular basis to ensure that they are in proper operating condition. By 

taking appropriate safety measures and carefully laying the power cable, 

ensure that the cable cannot be damaged and that no one can be hurt by, for 

example, tripping over the cable or suffering an electric shock.  

6. The product may be operated only from TN/TT supply networks fuse-protected 

with max. 16 A (higher fuse only after consulting with the Rohde & Schwarz 

group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly 

and all the way into the socket provided for this purpose. Otherwise, sparks 

that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so 

can cause fire or electric shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures 

(e.g. appropriate measuring equipment, fuse protection, current limiting, 

electrical separation, insulation) should be taken to avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs 

or other industrial computers, comply with the IEC 60950-1 / EN 60950-1 or 

IEC 61010-1 / EN 61010-1 standards that apply in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing 

while the product is in operation. Doing so will expose circuits and 

components and can lead to injuries, fire or damage to the product. 
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12. If a product is to be permanently installed, the connection between the 

protective conductor terminal on site and the product's protective conductor 

must be made first before any other connection is made. The product may be 

installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or 

similar protective devices, the supply circuit must be fuse-protected in such a 

way that anyone who has access to the product, as well as the product itself, 

is adequately protected from injury or damage. 

14. Use suitable overvoltage protection to ensure that no overvoltage (such as 

that caused by a bolt of lightning) can reach the product. Otherwise, the 

person operating the product will be exposed to the danger of an electric 

shock. 

15. Any object that is not designed to be placed in the openings of the housing 

must not be used for this purpose. Doing so can cause short circuits inside the 

product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section 

"Operating states and operating positions", item 1). Therefore, the equipment 

must be protected against penetration by liquids. If the necessary precautions 

are not taken, the user may suffer electric shock or the product itself may be 

damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or 

can form in or on the product, e.g. if the product has been moved from a cold 

to a warm environment. Penetration by water increases the risk of electric 

shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply 

(e.g. AC supply network or battery). Use a soft, non-linting cloth to clean the 

product. Never use chemical cleaning agents such as alcohol, acetone or 

diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. 

Make sure that persons who use the products are physically, mentally and 

emotionally fit enough to do so; otherwise, injuries or material damage may 

occur. It is the responsibility of the employer/operator to select suitable 

personnel for operating the products. 

2. Before you move or transport the product, read and observe the section titled 

"Transport". 
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3. As with all industrially manufactured goods, the use of substances that induce 

an allergic reaction (allergens) such as nickel cannot be generally excluded. If 

you develop an allergic reaction (such as a skin rash, frequent sneezing, red 

eyes or respiratory difficulties) when using a Rohde & Schwarz product, 

consult a physician immediately to determine the cause and to prevent health 

problems or stress.  

4. Before you start processing the product mechanically and/or thermally, or 

before you take it apart, be sure to read and pay special attention to the 

section titled "Waste disposal/Environmental protection", item 1. 

5. Depending on the function, certain products such as RF radio equipment can 

produce an elevated level of electromagnetic radiation. Considering that 

unborn babies require increased protection, pregnant women must be 

protected by appropriate measures. Persons with pacemakers may also be 

exposed to risks from electromagnetic radiation. The employer/operator must 

evaluate workplaces where there is a special risk of exposure to radiation and, 

if necessary, take measures to avert the potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, 

fluids, etc.) that can cause health problems. Therefore, suitable measures 

must be taken, e.g. protective masks and protective clothing must be worn. 

7. Laser products are given warning labels that are standardized according to 

their laser class. Lasers can cause biological harm due to the properties of 

their radiation and due to their extremely concentrated electromagnetic power. 

If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz 

product, absolutely no other settings or functions may be used as described in 

the product documentation. The objective is to prevent personal injury (e.g. 

due to laser beams). 

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 

55022/CISPR 22, EN 55032/CISPR 32) 

 Class A equipment:  

Equipment suitable for use in all environments except residential 

environments and environments that are directly connected to a low-

voltage supply network that supplies residential buildings  

Note: Class A equipment is intended for use in an industrial environment. 

This equipment may cause radio disturbances in residential environments, 

due to possible conducted as well as radiated disturbances. In this case, 

the operator may be required to take appropriate measures to eliminate 

these disturbances. 
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 Class B equipment: 

Equipment suitable for use in residential environments and environments 

that are directly connected to a low-voltage supply network that supplies 

residential buildings 

Repair and service 

1. The product may be opened only by authorized, specially trained personnel. 

Before any work is performed on the product or before the product is opened, 

it must be disconnected from the AC supply network. Otherwise, personnel will 

be exposed to the risk of an electric shock.  

2. Adjustments, replacement of parts, maintenance and repair may be performed 

only by electrical experts authorized by Rohde & Schwarz. Only original parts 

may be used for replacing parts relevant to safety (e.g. power switches, power 

transformers, fuses). A safety test must always be performed after parts 

relevant to safety have been replaced (visual inspection, protective conductor 

test, insulation resistance measurement, leakage current measurement, 

functional test). This helps ensure the continued safety of the product.  

Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not 

observed either at all or to the extent necessary, product users may be exposed 

to the risk of explosions, fire and/or serious personal injury, and, in some cases, 

death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. lithium 

cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight 

must be avoided. Keep cells and batteries clean and dry. Clean soiled 

connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be 

stored in a box or in a drawer where they can short-circuit each other, or 

where they can be short-circuited by other conductive materials. Cells and 

batteries must not be removed from their original packaging until they are 

ready to be used. 

4. Cells and batteries must not be exposed to any mechanical shocks that are 

stronger than permitted. 

5. If a cell develops a leak, the fluid must not be allowed to come into contact 

with the skin or eyes. If contact occurs, wash the affected area with plenty of 

water and seek medical aid. 
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6. Improperly replacing or charging cells or batteries that contain alkaline 

electrolytes (e.g. lithium cells) can cause explosions. Replace cells or batteries 

only with the matching Rohde & Schwarz type (see parts list) in order to 

ensure the safety of the product.  

7. Cells and batteries must be recycled and kept separate from residual waste. 

Rechargeable batteries and normal batteries that contain lead, mercury or 

cadmium are hazardous waste. Observe the national regulations regarding 

waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with 

care. In some cases, the user may require a suitable means of lifting or 

moving the product (e.g. with a lift-truck) to avoid back or other physical 

injuries.  

2. Handles on the products are designed exclusively to enable personnel to 

transport the product. It is therefore not permissible to use handles to fasten 

the product to or on transport equipment such as cranes, fork lifts, wagons, 

etc. The user is responsible for securely fastening the products to or on the 

means of transport or lifting. Observe the safety regulations of the 

manufacturer of the means of transport or lifting. Noncompliance can result in 

personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to 

drive the vehicle safely and properly. The manufacturer assumes no 

responsibility for accidents or collisions. Never use the product in a moving 

vehicle if doing so could distract the driver of the vehicle. Adequately secure 

the product in the vehicle to prevent injuries or other damage in the event of 

an accident.  

Waste disposal/Environmental protection 

1. Specially marked equipment has a battery or accumulator that must not be 

disposed of with unsorted municipal waste, but must be collected separately. It 

may only be disposed of at a suitable collection point or via a 

Rohde & Schwarz customer service center. 

2. Waste electrical and electronic equipment must not be disposed of with 

unsorted municipal waste, but must be collected separately. 

Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and 

takes full responsibility for take-back obligations and disposal obligations for 

manufacturers within the EU. Contact your Rohde & Schwarz customer 

service center for environmentally responsible disposal of the product. 
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3. If products or their components are mechanically and/or thermally processed 

in a manner that goes beyond their intended use, hazardous substances 

(heavy-metal dust such as lead, beryllium, nickel) may be released. For this 

reason, the product may only be disassembled by specially trained personnel. 

Improper disassembly may be hazardous to your health. National waste 

disposal regulations must be observed.  

4. If handling the product releases hazardous substances or fuels that must be 

disposed of in a special way, e.g. coolants or engine oils that must be 

replenished regularly, the safety instructions of the manufacturer of the 

hazardous substances or fuels and the applicable regional waste disposal 

regulations must be observed. Also observe the relevant safety instructions in 

the product documentation. The improper disposal of hazardous substances 

or fuels can cause health problems and lead to environmental damage. 

For additional information about environmental protection, visit the 

Rohde & Schwarz website. 

 

 

Instrucciones de seguridad elementales 

¡Es imprescindible leer y cumplir las siguientes instrucciones e 

informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros 

productos siempre al día con los estándares de seguridad y de ofrecer a nuestros 

clientes el máximo grado de seguridad. Nuestros productos y todos los equipos 

adicionales son siempre fabricados y examinados según las normas de 

seguridad vigentes. Nuestro sistema de garantía de calidad controla 

constantemente que sean cumplidas estas normas. El presente producto ha sido 

fabricado y examinado según el certificado de conformidad de la UE y ha salido 

de nuestra planta en estado impecable según los estándares técnicos de 

seguridad. Para poder preservar este estado y garantizar un funcionamiento libre 

de peligros, el usuario deberá atenerse a todas las indicaciones, informaciones 

de seguridad y notas de alerta. El grupo de empresas Rohde & Schwarz está 

siempre a su disposición en caso de que tengan preguntas referentes a estas 

informaciones de seguridad. 
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Además queda en la responsabilidad del usuario utilizar el producto en la forma 

debida. Este producto está destinado exclusivamente al uso en la industria y el 

laboratorio o, si ha sido expresamente autorizado, para aplicaciones de campo y 

de ninguna manera deberá ser utilizado de modo que alguna persona/cosa 

pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en 

cuenta las instrucciones del fabricante queda en la responsabilidad del usuario. 

El fabricante no se hace en ninguna forma responsable de consecuencias a 

causa del mal uso del producto.  

Se parte del uso correcto del producto para los fines definidos si el producto es 

utilizado conforme a las indicaciones de la correspondiente documentación del 

producto y dentro del margen de rendimiento definido (ver hoja de datos, 

documentación, informaciones de seguridad que siguen). El uso del producto 

hace necesarios conocimientos técnicos y ciertos conocimientos del idioma 

inglés. Por eso se debe tener en cuenta que el producto solo pueda ser operado 

por personal especializado o personas instruidas en profundidad con las 

capacidades correspondientes. Si fuera necesaria indumentaria de seguridad 

para el uso de productos de Rohde & Schwarz, encontraría la información debida 

en la documentación del producto en el capítulo correspondiente. Guarde bien 

las informaciones de seguridad elementales, así como la documentación del 

producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible 

lesiones o daños por peligros de toda clase. Por eso es imprescindible leer 

detalladamente y comprender por completo las siguientes informaciones de 

seguridad antes de usar el producto, y respetarlas durante el uso del producto. 

Deberán tenerse en cuenta todas las demás informaciones de seguridad, como 

p. ej. las referentes a la protección de personas, que encontrarán en el capítulo 

correspondiente de la documentación del producto y que también son de 

obligado cumplimiento. En las presentes informaciones de seguridad se recogen 

todos los objetos que distribuye el grupo de empresas Rohde & Schwarz bajo la 

denominación de "producto", entre ellos también aparatos, instalaciones así 

como toda clase de accesorios. Los datos específicos del producto figuran en la 

hoja de datos y en la documentación del producto. 
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Señalización de seguridad de los productos 

Las siguientes señales de seguridad se utilizan en los productos para advertir 

sobre riesgos y peligros. 

Símbolo Significado Símbolo Significado 

 

Aviso: punto de peligro general 

Observar la documentación del 
producto 

    Tensión de alimentación de 
PUESTA EN MARCHA / PARADA 

 

Atención en el manejo de 
dispositivos de peso elevado  

Indicación de estado de espera 
(standby) 

 

Peligro de choque eléctrico  Corriente continua (DC) 

 

Advertencia: superficie caliente  Corriente alterna (AC) 

 

Conexión a conductor de 
protección 

 Corriente continua / Corriente 
alterna (DC/AC) 

 

Conexión a tierra 
 

El aparato está protegido en su 
totalidad por un aislamiento doble 
(reforzado) 

 

Conexión a masa 

 

Distintivo de la UE para baterías y 
acumuladores 

Más información en la sección 
"Eliminación/protección del medio 
ambiente", punto 1. 

 

Aviso: Cuidado en el manejo de 
dispositivos sensibles a la 
electrostática (ESD) 

 

Distintivo de la UE para la 
eliminación por separado de 
dispositivos eléctricos y 
electrónicos 

Más información en la sección 
"Eliminación/protección del medio 
ambiente", punto 2. 

 

Advertencia: rayo láser 

Más información en la sección 
"Funcionamiento", punto 7. 
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Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal 

con el fin de advertir contra riesgos y peligros. 

 

Indica una situación de peligro que, si no se evita, 

causa lesiones graves o incluso la muerte. 

 

Indica una situación de peligro que, si no se evita, 

puede causar lesiones graves o incluso la muerte. 

 

Indica una situación de peligro que, si no se evita, 

puede causar lesiones leves o moderadas. 

 

Indica información que se considera importante, pero 

no en relación con situaciones de peligro; p. ej., avisos 

sobre posibles daños materiales.  

En la documentación del producto se emplea de forma 

sinónima el término CUIDADO. 

 

Las palabras de señal corresponden a la definición habitual para aplicaciones 

civiles en el área económica europea. Pueden existir definiciones diferentes a 

esta definición en otras áreas económicas o en aplicaciones militares. Por eso se 

deberá tener en cuenta que las palabras de señal aquí descritas sean utilizadas 

siempre solamente en combinación con la correspondiente documentación del 

producto y solamente en combinación con el producto correspondiente. La 

utilización de las palabras de señal en combinación con productos o 

documentaciones que no les correspondan puede llevar a interpretaciones 

equivocadas y tener por consecuencia daños en personas u objetos. 
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Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante 

respecto a los estados operativos y posiciones de funcionamiento sin que se 

obstruya la ventilación. Si no se siguen las indicaciones del fabricante, pueden 

producirse choques eléctricos, incendios y/o lesiones graves con posible 

consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las 

normas nacionales y locales de seguridad del trabajo y de prevención de 

accidentes.  

1. Si no se convino de otra manera, es para los productos Rohde & Schwarz 

válido lo que sigue:  

como posición de funcionamiento se define por principio la posición con el 

suelo de la caja para abajo, modo de protección IP 2X, uso solamente en 

estancias interiores, utilización hasta 2000 m sobre el nivel del mar, transporte 

hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de ±10 % 

sobre el voltaje nominal y de ±5 % sobre la frecuencia nominal. Categoría de 

sobrecarga eléctrica 2, índice de suciedad 2.  

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que 

por sus características de peso o de estabilidad no sean aptos para él. Siga 

siempre las instrucciones de instalación del fabricante cuando instale y 

asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si se 

realiza la instalación de modo distinto al indicado en la documentación del 

producto, se pueden causar lesiones o, en determinadas circunstancias, 

incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o 

calefactores). La temperatura ambiente no debe superar la temperatura 

máxima especificada en la documentación del producto o en la hoja de datos. 

En caso de sobrecalentamiento del producto, pueden producirse choques 

eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 

Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante 

en cuanto a seguridad eléctrica, pueden producirse choques eléctricos, incendios 

y/o lesiones graves con posible consecuencia de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que 

la tensión preseleccionada en el producto coincida con la de la red de 

alimentación eléctrica. Si es necesario modificar el ajuste de tensión, también 

se deberán cambiar en caso dado los fusibles correspondientes del producto.  



Instrucciones de seguridad elementales 

1171.0000.52 - 08 Page 15 

2. Los productos de la clase de protección I con alimentación móvil y enchufe 

individual solamente podrán enchufarse a tomas de corriente con contacto de 

seguridad y con conductor de protección conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, 

tanto en la toma de corriente como en el mismo producto. La interrupción 

puede tener como consecuencia el riesgo de que el producto sea fuente de 

choques eléctricos. Si se utilizan cables alargadores o regletas de enchufe, 

deberá garantizarse la realización de un examen regular de los mismos en 

cuanto a su estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la 

red, o bien si el interruptor existente no resulta apropiado para la desconexión 

de la red, el enchufe del cable de conexión se deberá considerar como un 

dispositivo de desconexión.  

El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar 

siempre bien accesible. Si, p. ej., el enchufe de conexión a la red es el 

dispositivo de desconexión, la longitud del cable de conexión no debe superar 

3 m).  

Los interruptores selectores o electrónicos no son aptos para el corte de la red 

eléctrica. Si se integran productos sin interruptor en bastidores o 

instalaciones, se deberá colocar el interruptor en el nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. 

Compruebe regularmente el correcto estado de los cables de conexión a red. 

Asegúrese, mediante las medidas de protección y de instalación adecuadas, 

de que el cable de conexión a red no pueda ser dañado o de que nadie pueda 

ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  

6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT 

aseguradas con fusibles de 16 A como máximo (utilización de fusibles de 

mayor amperaje solo previa consulta con el grupo de empresas Rohde & 

Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. 

Introduzca el enchufe por completo y fuertemente en la toma de corriente. La 

no observación de estas medidas puede provocar chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas 

de enchufe ya que esto podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se 

deberán tomar las medidas apropiadas para impedir cualquier peligro (p. ej. 

medios de medición adecuados, seguros, limitación de tensión, corte 

protector, aislamiento etc.). 
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10. Para la conexión con dispositivos informáticos como un PC o un ordenador 

industrial, debe comprobarse que éstos cumplan los estándares IEC60950-

1/EN60950-1 o IEC61010-1/EN 61010-1 válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni 

componentes de la carcasa mientras el producto esté en servicio. Esto pone a 

descubierto los cables y componentes eléctricos y puede causar lesiones, 

fuego o daños en el producto. 

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el 

conductor de protección fijo con el conductor de protección del producto antes 

de hacer cualquier otra conexión. La instalación y la conexión deberán ser 

efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor 

automático ni otros mecanismos de seguridad similares, el circuito de 

alimentación debe estar protegido de modo que todas las personas que 

puedan acceder al producto, así como el producto mismo, estén a salvo de 

posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una 

caída del rayo) mediante los correspondientes sistemas de protección. Si no, 

el personal que lo utilice quedará expuesto al peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que 

no esté destinado a ello. Esto puede producir cortocircuitos en el producto y/o 

puede causar choques eléctricos, fuego o lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver 

también el capítulo "Estados operativos y posiciones de funcionamiento", 

punto 1). Por eso es necesario tomar las medidas necesarias para evitar la 

entrada de líquidos. En caso contrario, existe peligro de choque eléctrico para 

el usuario o de daños en el producto, que también pueden redundar en 

peligro para las personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se 

hayan producido condensaciones sobre el producto o en el interior de éste, 

como p. ej. al desplazarlo de un lugar frío a otro caliente. La entrada de agua 

aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación 

de tensión (p. ej. red de alimentación o batería). Realice la limpieza de los 

aparatos con un paño suave, que no se deshilache. No utilice bajo ningún 

concepto productos de limpieza químicos como alcohol, acetona o diluyentes 

para lacas nitrocelulósicas. 
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Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración 

durante el manejo. Debe asegurarse que las personas que manejen el 

producto estén a la altura de los requerimientos necesarios en cuanto a 

aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 

pueden excluir lesiones o daños de objetos. El empresario u operador es 

responsable de seleccionar el personal usuario apto para el manejo del 

producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo 

"Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida 

en general la posibilidad de que se produzcan alergias provocadas por 

algunos materiales empleados ―los llamados alérgenos (p. ej. el níquel)―. Si 

durante el manejo de productos Rohde & Schwarz se producen reacciones 

alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, 

enrojecimiento de la conjuntiva o dificultades respiratorias, debe avisarse 

inmediatamente a un médico para investigar las causas y evitar cualquier 

molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, 

debe tenerse en cuenta imprescindiblemente el capítulo 

"Eliminación/protección del medio ambiente", punto 1. 

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, 

pueden a causa de su función natural, emitir una radiación electromagnética 

aumentada. Deben tomarse todas las medidas necesarias para la protección 

de las mujeres embarazadas. También las personas con marcapasos pueden 

correr peligro a causa de la radiación electromagnética. El 

empresario/operador tiene la obligación de evaluar y señalizar las áreas de 

trabajo en las que exista un riesgo elevado de exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto 

sustancias tóxicas (gases, líquidos etc.) que pueden generar daños a la salud. 

Por eso, en caso de incendio deben usarse medidas adecuadas, como p. ej. 

máscaras antigás e indumentaria de protección. 
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7. Los productos con láser están provistos de indicaciones de advertencia 

normalizadas en función de la clase de láser del que se trate. Los rayos láser 

pueden provocar daños de tipo biológico a causa de las propiedades de su 

radiación y debido a su concentración extrema de potencia electromagnética. 

En caso de que un producto Rohde & Schwarz contenga un producto láser (p. 

ej. un lector de CD/DVD), no debe usarse ninguna otra configuración o 

función aparte de las descritas en la documentación del producto, a fin de 

evitar lesiones (p. ej. debidas a irradiación láser). 

8. Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 

11; y en analogía con EN 55022 / CISPR 22, EN 55032 / CISPR 32) 

 Aparato de clase A:  

Aparato adecuado para su uso en todos los entornos excepto en los 

residenciales y en aquellos conectados directamente a una red de 

distribución de baja tensión que suministra corriente a edificios 

residenciales.  

Nota: Los aparatos de clase A están destinados al uso en entornos 

industriales. Estos aparatos pueden causar perturbaciones radioeléctricas 

en entornos residenciales debido a posibles perturbaciones guiadas o 

radiadas. En este caso, se le podrá solicitar al operador que tome  las 

medidas adecuadas para eliminar estas perturbaciones. 

 Aparato de clase B: 

Aparato adecuado para su uso en entornos residenciales, así como en 

aquellos conectados directamente a una red de distribución de baja 

tensión que suministra corriente a edificios residenciales. 

Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con 

autorización para ello. Antes de manipular el producto o abrirlo, es obligatorio 

desconectarlo de la tensión de alimentación, para evitar toda posibilidad de 

choque eléctrico.  

2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser 

efectuadas solamente por electricistas autorizados por Rohde & Schwarz. Si 

se reponen partes con importancia para los aspectos de seguridad (p. ej. el 

enchufe, los transformadores o los fusibles), solamente podrán ser sustituidos 

por partes originales. Después de cada cambio de partes relevantes para la 

seguridad deberá realizarse un control de seguridad (control a primera vista, 

control del conductor de protección, medición de resistencia de aislamiento, 

medición de la corriente de fuga, control de funcionamiento). Con esto queda 

garantizada la seguridad del producto.  
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Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a 

las baterías y acumuladores o celdas, pueden producirse explosiones, incendios 

y/o lesiones graves con posible consecuencia de muerte. El manejo de baterías y 

acumuladores con electrolitos alcalinos (p. ej. celdas de litio) debe seguir el 

estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el 

almacenamiento a la luz directa del sol. Las celdas y baterías deben 

mantenerse limpias y secas. Limpiar las conexiones sucias con un paño seco 

y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las 

celdas o baterías en estuches o cajones en cuyo interior puedan 

cortocircuitarse por contacto recíproco o por contacto con otros materiales 

conductores. No deben extraerse las celdas o baterías de sus embalajes 

originales hasta el momento en que vayan a utilizarse. 

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes 

indebidos. 

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe 

entrar en contacto con la piel ni los ojos. Si se produce contacto, lavar con 

agua abundante la zona afectada y avisar a un médico. 

6. En caso de cambio o recarga inadecuados, las celdas o baterías que 

contienen electrolitos alcalinos (p. ej. las celdas de litio) pueden explotar. Para 

garantizar la seguridad del producto, las celdas o baterías solo deben ser 

sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 

recambios).  

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura 

doméstica. Las baterías o acumuladores que contienen plomo, mercurio o 

cadmio deben tratarse como residuos especiales. Respete en esta relación 

las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o 

transportarlo con precaución y, si es necesario, usando un sistema de 

elevación adecuado (p. ej. una carretilla elevadora), a fin de evitar lesiones en 

la espalda u otros daños personales.  
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2. Las asas instaladas en los productos sirven solamente de ayuda para el 

transporte del producto por personas. Por eso no está permitido utilizar las 

asas para la sujeción en o sobre medios de transporte como p. ej. grúas, 

carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 

productos de manera segura a los medios de transporte o elevación. Para 

evitar daños personales o daños en el producto, siga las instrucciones de 

seguridad del fabricante del medio de transporte o elevación utilizado. 

3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en 

el conductor la responsabilidad de conducir el vehículo de manera segura y 

adecuada. El fabricante no asumirá ninguna responsabilidad por accidentes o 

colisiones. No utilice nunca el producto dentro de un vehículo en movimiento 

si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 

debidamente para evitar, en caso de un accidente, lesiones u otra clase de 

daños.  

Eliminación/protección del medio ambiente 

1. Los dispositivos marcados contienen una batería o un acumulador que no se 

debe desechar con los residuos domésticos sin clasificar, sino que debe ser 

recogido por separado. La eliminación se debe efectuar exclusivamente a 

través de un punto de recogida apropiado o del servicio de atención al cliente 

de Rohde & Schwarz. 

2. Los dispositivos eléctricos usados no se deben desechar con los residuos 

domésticos sin clasificar, sino que deben ser recogidos por separado. 

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación 

de residuos y asume plenamente los deberes de recogida y eliminación para 

los fabricantes dentro de la UE. Para desechar el producto de manera 

respetuosa con el medio ambiente, diríjase a su servicio de atención al cliente 

de Rohde & Schwarz. 

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o 

componente más allá del funcionamiento previsto, pueden liberarse 

sustancias peligrosas (polvos con contenido de metales pesados como p. ej. 

plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 

personal especializado con formación adecuada. Un desmontaje inadecuado 

puede ocasionar daños para la salud. Se deben tener en cuenta las directivas 

nacionales referentes a la eliminación de residuos. 
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4. En caso de que durante el trato del producto se formen sustancias peligrosas 

o combustibles que deban tratarse como residuos especiales (p. ej. 

refrigerantes o aceites de motor con intervalos de cambio definidos), deben 

tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 

sustancias y las normas regionales de eliminación de residuos. Tenga en 

cuenta también en caso necesario las indicaciones de seguridad especiales 

contenidas en la documentación del producto. La eliminación incorrecta de 

sustancias peligrosas o combustibles puede causar daños a la salud o daños 

al medio ambiente. 

Se puede encontrar más información sobre la protección del medio ambiente en 

la página web de Rohde & Schwarz. 
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Grundlegende Sicherheitshinweise 

Lesen und beachten Sie unbedingt die nachfolgenden Anweisungen und 

Sicherheitshinweise! 

Alle Werke und Standorte der Rohde & Schwarz Firmengruppe sind ständig 

bemüht, den Sicherheitsstandard unserer Produkte auf dem aktuellsten Stand zu 

halten und unseren Kunden ein höchstmögliches Maß an Sicherheit zu bieten. 

Unsere Produkte und die dafür erforderlichen Zusatzgeräte werden entsprechend 

der jeweils gültigen Sicherheitsvorschriften gebaut und geprüft. Die Einhaltung 

dieser Bestimmungen wird durch unser Qualitätssicherungssystem laufend 

überwacht. Das vorliegende Produkt ist gemäß beiliegender EU-

Konformitätsbescheinigung gebaut und geprüft und hat das Werk in 

sicherheitstechnisch einwandfreiem Zustand verlassen. Um diesen Zustand zu 

erhalten und einen gefahrlosen Betrieb sicherzustellen, muss der Benutzer alle 

Hinweise, Warnhinweise und Warnvermerke beachten. Bei allen Fragen 

bezüglich vorliegender Sicherheitshinweise steht Ihnen die Rohde & Schwarz 

Firmengruppe jederzeit gerne zur Verfügung. 

Darüber hinaus liegt es in der Verantwortung des Benutzers, das Produkt in 

geeigneter Weise zu verwenden. Das Produkt ist ausschließlich für den Betrieb in 

Industrie und Labor bzw., wenn ausdrücklich zugelassen, auch für den 

Feldeinsatz bestimmt und darf in keiner Weise so verwendet werden, dass einer 

Person/Sache Schaden zugefügt werden kann. Die Benutzung des Produkts 

außerhalb des bestimmungsgemäßen Gebrauchs oder unter Missachtung der 

Anweisungen des Herstellers liegt in der Verantwortung des Benutzers. Der 

Hersteller übernimmt keine Verantwortung für die Zweckentfremdung des 

Produkts.  

Die bestimmungsgemäße Verwendung des Produkts wird angenommen, wenn 

das Produkt nach den Vorgaben der zugehörigen Produktdokumentation 

innerhalb seiner Leistungsgrenzen verwendet wird (siehe Datenblatt, Doku-

mentation, nachfolgende Sicherheitshinweise). Die Benutzung des Produkts 

erfordert Fachkenntnisse und zum Teil englische Sprachkenntnisse. Es ist daher 

zu beachten, dass das Produkt ausschließlich von Fachkräften oder sorgfältig 

eingewiesenen Personen mit entsprechenden Fähigkeiten bedient werden darf. 

Sollte für die Verwendung von Rohde & Schwarz-Produkten persönliche 

Schutzausrüstung erforderlich sein, wird in der Produktdokumentation an 

entsprechender Stelle darauf hingewiesen. Bewahren Sie die grundlegenden 

Sicherheitshinweise und die Produktdokumentation gut auf und geben Sie diese 

an weitere Benutzer des Produkts weiter. 
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Die Einhaltung der Sicherheitshinweise dient dazu, Verletzungen oder Schäden 

durch Gefahren aller Art auszuschließen. Hierzu ist es erforderlich, dass die 

nachstehenden Sicherheitshinweise vor der Benutzung des Produkts sorgfältig 

gelesen und verstanden sowie bei der Benutzung des Produkts beachtet werden. 

Sämtliche weitere Sicherheitshinweise wie z.B. zum Personenschutz, die an 

entsprechender Stelle der Produktdokumentation stehen, sind ebenfalls 

unbedingt zu beachten. In den vorliegenden Sicherheitshinweisen sind sämtliche 

von der Rohde & Schwarz Firmengruppe vertriebenen Waren unter dem Begriff 

„Produkt“ zusammengefasst, hierzu zählen u. a. Geräte, Anlagen sowie 

sämtliches Zubehör.  

Symbole und Sicherheitskennzeichnungen 

Symbol Bedeutung Symbol Bedeutung 

 

Achtung, allgemeine 
Gefahrenstelle 

Produktdokumentation beachten 

    EIN-/AUS (Versorgung) 

 

Vorsicht beim Umgang mit 
Geräten mit hohem Gewicht  

Stand-by-Anzeige 

 

Gefahr vor elektrischem Schlag  Gleichstrom (DC) 

 

Warnung vor heißer Oberfläche  Wechselstrom (AC) 

 

Schutzleiteranschluss  Gleichstrom/Wechselstrom 
(DC/AC) 

 

Erdungsanschluss  
 

Gerät entspricht den Sicherheits-
anforderungen an die 
Schutzklasse II  
(Gerät durchgehend durch 
doppelte / verstärkte Isolierung 
geschützt. 

 

Masseanschluss des Gestells 
oder Gehäuses 

 

EU - Kennzeichnung für Batterien 
und Akkumulatoren. Das Gerät 
enthält eine Batterie bzw. einen 
Akkumulator. Diese dürfen nicht 
über unsortierten Siedlungsabfall 
entsorgt werden, sondern sollten 
getrennt gesammelt werden. 

Weitere Informationen siehe 
Seite 11. 
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Symbol Bedeutung Symbol Bedeutung 

 

Achtung beim Umgang mit 
elektrostatisch gefährdeten 
Bauelementen 

 

EU - Kennzeichnung für die 
getrennte Sammlung von Elektro- 
und Elektronikgeräten. 

Elektroaltgeräte dürfen nicht über 
unsortierten Siedlungsabfall 
entsorgt werden, sondern 
müssen getrennt gesammelt 
werden.  
 
Weitere Informationen siehe 
Seite 11. 

 

Warnung vor Laserstrahl 
Produkte mit Laser sind je nach 
ihrer Laser-Klasse mit genormten 
Warnhinweisen versehen. 
Laser können aufgrund der 
Eigenschaften ihrer Strahlung 
und aufgrund ihrer extrem 
konzentrierten 
elektromagnetischen Leistung 
biologische Schäden 
verursachen.  
 
Für zusätzliche Informationen 
siehe Kapitel „Betrieb“ Punkt 7. 

  

 

http://de.wikipedia.org/wiki/Laser#Laser-Klassen
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Signalworte und ihre Bedeutung 

Die folgenden Signalworte werden in der Produktdokumentation verwendet, um 

vor Risiken und Gefahren zu warnen. 

 
kennzeichnet eine unmittelbare Gefährdung mit hohem 

Risiko, die Tod oder schwere Körperverletzung zur Folge 

haben wird, wenn sie nicht vermieden wird.  

 
kennzeichnet eine mögliche Gefährdung mit mittlerem 

Risiko, die Tod oder (schwere) Körperverletzung zur Folge 

haben kann, wenn sie nicht vermieden wird. 

 
kennzeichnet eine Gefährdung mit geringem Risiko, die 

leichte oder mittlere Körperverletzungen zur Folge haben 

könnte, wenn sie nicht vermieden wird. 

 
weist auf die Möglichkeit einer Fehlbedienung hin, bei der 

das Produkt Schaden nehmen kann. 

 
Diese Signalworte entsprechen der im europäischen Wirtschaftsraum üblichen 

Definition für zivile Anwendungen. Neben dieser Definition können in anderen 

Wirtschaftsräumen oder bei militärischen Anwendungen abweichende 

Definitionen existieren. Es ist daher darauf zu achten, dass die hier 

beschriebenen Signalworte stets nur in Verbindung mit der zugehörigen 

Produktdokumentation und nur in Verbindung mit dem zugehörigen Produkt 

verwendet werden. Die Verwendung von Signalworten in Zusammenhang mit 

nicht zugehörigen Produkten oder nicht zugehörigen Dokumentationen kann zu 

Fehlinterpretationen führen und damit zu Personen- oder Sachschäden führen. 

Betriebszustände und Betriebslagen 

Das Produkt darf nur in den vom Hersteller angegebenen Betriebszuständen und 

Betriebslagen ohne Behinderung der Belüftung betrieben werden. Werden die 

Herstellerangaben nicht eingehalten, kann dies elektrischen Schlag, Brand 

und/oder schwere Verletzungen von Personen, unter Umständen mit Todesfolge, 

verursachen. Bei allen Arbeiten sind die örtlichen bzw. landesspezifischen 

Sicherheits- und Unfallverhütungsvorschriften zu beachten.  

1. Sofern nicht anders vereinbart, gilt für R&S-Produkte folgendes:  

als vorgeschriebene Betriebslage grundsätzlich Gehäuseboden unten, IP-

Schutzart 2X, Verschmutzungsgrad 2, Überspannungskategorie 2, nur in 

Innenräumen verwenden, Betrieb bis 2000 m ü. NN, Transport bis 4500 m ü. 

NN, für die Nennspannung gilt eine Toleranz von ±10%, für die Nennfrequenz 

eine Toleranz von ±5%. 
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2. Stellen Sie das Produkt nicht auf Oberflächen, Fahrzeuge, Ablagen oder 

Tische, die aus Gewichts- oder Stabilitätsgründen nicht dafür geeignet sind. 

Folgen Sie bei Aufbau und Befestigung des Produkts an Gegenständen oder 

Strukturen (z.B. Wände und Regale) immer den Installationshinweisen des 

Herstellers. Bei Installation abweichend von der Produktdokumentation 

können Personen verletzt, unter Umständen sogar getötet werden. 

3. Stellen Sie das Produkt nicht auf hitzeerzeugende Gerätschaften (z.B. Radia-

toren und Heizlüfter). Die Umgebungstemperatur darf nicht die in der 

Produktdokumentation oder im Datenblatt spezifizierte Maximaltemperatur 

überschreiten. Eine Überhitzung des Produkts kann elektrischen Schlag, 

Brand und/oder schwere Verletzungen von Personen, unter Umständen mit 

Todesfolge, verursachen. 

Elektrische Sicherheit 

Werden die Hinweise zur elektrischen Sicherheit nicht oder unzureichend 

beachtet, kann dies elektrischen Schlag, Brand und/oder schwere Verletzungen 

von Personen, unter Umständen mit Todesfolge, verursachen.  

1. Vor jedem Einschalten des Produkts ist sicherzustellen, dass die am Produkt 

eingestellte Nennspannung und die Netznennspannung des 

Versorgungsnetzes übereinstimmen. Ist es erforderlich, die Spannungs-

einstellung zu ändern, so muss ggf. auch die dazu gehörige Netzsicherung 

des Produkts geändert werden.  

2. Bei Produkten der Schutzklasse I mit beweglicher Netzzuleitung und Geräte-

steckvorrichtung ist der Betrieb nur an Steckdosen mit Schutzkontakt und 

angeschlossenem Schutzleiter zulässig. 

3. Jegliche absichtliche Unterbrechung des Schutzleiters, sowohl in der Zuleitung 

als auch am Produkt selbst, ist unzulässig. Es kann dazu führen, dass von 

dem Produkt die Gefahr eines elektrischen Schlags ausgeht. Bei Verwendung 

von Verlängerungsleitungen oder Steckdosenleisten ist sicherzustellen, dass 

diese regelmäßig auf ihren sicherheitstechnischen Zustand überprüft werden. 
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4. Sofern das Produkt nicht mit einem Netzschalter zur Netztrennung 

ausgerüstet ist, beziehungsweise der vorhandene Netzschalter zu 

Netztrennung nicht geeignet ist, so ist der Stecker des Anschlusskabels als 

Trennvorrichtung anzusehen.  

Die Trennvorrichtung muss jederzeit leicht erreichbar und gut zugänglich sein. 

Ist z.B. der Netzstecker die Trennvorrichtung, darf die Länge des 

Anschlusskabels 3 m nicht überschreiten.  

Funktionsschalter oder elektronische Schalter sind zur Netztrennung nicht 

geeignet. Werden Produkte ohne Netzschalter in Gestelle oder Anlagen 

integriert, so ist die Trennvorrichtung auf Anlagenebene zu verlagern. 

5. Benutzen Sie das Produkt niemals, wenn das Netzkabel beschädigt ist. 

Überprüfen Sie regelmäßig den einwandfreien Zustand der Netzkabel. Stellen 

Sie durch geeignete Schutzmaßnahmen und Verlegearten sicher, dass das 

Netzkabel nicht beschädigt werden kann und niemand z.B. durch Stolperfallen 

oder elektrischen Schlag zu Schaden kommen kann.  

6. Der Betrieb ist nur an TN/TT Versorgungsnetzen gestattet, die mit höchstens 

16 A abgesichert sind (höhere Absicherung nur nach Rücksprache mit der 

Rohde & Schwarz Firmengruppe). 

7. Stecken Sie den Stecker nicht in verstaubte oder verschmutzte Steckdosen/-

buchsen. Stecken Sie die Steckverbindung/-vorrichtung fest und vollständig in 

die dafür vorgesehenen Steckdosen/-buchsen. Missachtung dieser Maß-

nahmen kann zu Funken, Feuer und/oder Verletzungen führen. 

8. Überlasten Sie keine Steckdosen, Verlängerungskabel oder Steckdosen-

leisten, dies kann Feuer oder elektrische Schläge verursachen. 

9. Bei Messungen in Stromkreisen mit Spannungen Ueff > 30 V ist mit 

geeigneten Maßnahmen Vorsorge zu treffen, dass jegliche Gefährdung 

ausgeschlossen wird (z.B. geeignete Messmittel, Absicherung, 

Strombegrenzung, Schutztrennung, Isolierung usw.). 

10. Bei Verbindungen mit informationstechnischen Geräten, z.B. PC oder 

Industrierechner, ist darauf zu achten, dass diese der jeweils gültigen IEC 

60950-1 / EN 60950-1 oder IEC 61010-1 / EN 61010-1 entsprechen. 

11. Sofern nicht ausdrücklich erlaubt, darf der Deckel oder ein Teil des Gehäuses 

niemals entfernt werden, wenn das Produkt betrieben wird. Dies macht 

elektrische Leitungen und Komponenten zugänglich und kann zu 

Verletzungen, Feuer oder Schaden am Produkt führen. 
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12. Wird ein Produkt ortsfest angeschlossen, ist die Verbindung zwischen dem 

Schutzleiteranschluss vor Ort und dem Geräteschutzleiter vor jeglicher 

anderer Verbindung herzustellen. Aufstellung und Anschluss darf nur durch 

eine Elektrofachkraft erfolgen. 

13. Bei ortsfesten Geräten ohne eingebaute Sicherung, Selbstschalter oder 

ähnliche Schutzeinrichtung muss der Versorgungskreis so abgesichert sein, 

dass alle Personen, die Zugang zum Produkt haben, sowie das Produkt selbst 

ausreichend vor Schäden geschützt sind. 

14. Jedes Produkt muss durch geeigneten Überspannungsschutz vor Über-

spannung (z.B. durch Blitzschlag) geschützt werden. Andernfalls ist das 

bedienende Personal durch elektrischen Schlag gefährdet. 

15. Gegenstände, die nicht dafür vorgesehen sind, dürfen nicht in die Öffnungen 

des Gehäuses eingebracht werden. Dies kann Kurzschlüsse im Produkt 

und/oder elektrische Schläge, Feuer oder Verletzungen verursachen. 

16. Sofern nicht anders spezifiziert, sind Produkte nicht gegen das Eindringen von 

Flüssigkeiten geschützt, siehe auch Abschnitt "Betriebszustände und 

Betriebslagen", Punkt 1. Daher müssen die Geräte vor Eindringen von 

Flüssigkeiten geschützt werden. Wird dies nicht beachtet, besteht Gefahr 

durch elektrischen Schlag für den Benutzer oder Beschädigung des Produkts, 

was ebenfalls zur Gefährdung von Personen führen kann. 

17. Benutzen Sie das Produkt nicht unter Bedingungen, bei denen Kondensation 

in oder am Produkt stattfinden könnte oder ggf. bereits stattgefunden hat, z.B. 

wenn das Produkt von kalter in warme Umgebung bewegt wurde. Das 

Eindringen von Wasser erhöht das Risiko eines elektrischen Schlages. 

18. Trennen Sie das Produkt vor der Reinigung komplett von der 

Energieversorgung (z.B. speisendes Netz oder Batterie). Nehmen Sie bei 

Geräten die Reinigung mit einem weichen, nicht fasernden Staublappen vor. 

Verwenden Sie keinesfalls chemische Reinigungsmittel wie z.B. Alkohol, 

Aceton, Nitroverdünnung. 

Betrieb 

1. Die Benutzung des Produkts erfordert spezielle Einweisung und hohe 

Konzentration während der Benutzung. Es muss sichergestellt sein, dass 

Personen, die das Produkt bedienen, bezüglich ihrer körperlichen, geistigen 

und seelischen Verfassung den Anforderungen gewachsen sind, da 

andernfalls Verletzungen oder Sachschäden nicht auszuschließen sind. Es 

liegt in der Verantwortung des Arbeitsgebers/Betreibers, geeignetes Personal 

für die Benutzung des Produkts auszuwählen. 
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2. Bevor Sie das Produkt bewegen oder transportieren, lesen und beachten Sie 

den Abschnitt "Transport". 

3. Wie bei allen industriell gefertigten Gütern kann die Verwendung von Stoffen, 

die Allergien hervorrufen - so genannte Allergene (z.B. Nickel) - nicht generell 

ausgeschlossen werden. Sollten beim Umgang mit R&S-Produkten allergische 

Reaktionen, z.B. Hautausschlag, häufiges Niesen, Bindehautrötung oder 

Atembeschwerden auftreten, ist umgehend ein Arzt aufzusuchen, um die 

Ursachen zu klären und Gesundheitsschäden bzw. -belastungen zu 

vermeiden.  

4. Vor der mechanischen und/oder thermischen Bearbeitung oder Zerlegung des 

Produkts beachten Sie unbedingt Abschnitt "Entsorgung", Punkt 1. 

5. Bei bestimmten Produkten, z.B. HF-Funkanlagen, können funktionsbedingt 

erhöhte elektromagnetische Strahlungen auftreten. Unter Berücksichtigung 

der erhöhten Schutzwürdigkeit des ungeborenen Lebens müssen Schwangere 

durch geeignete Maßnahmen geschützt werden. Auch Träger von 

Herzschrittmachern können durch elektromagnetische Strahlungen gefährdet 

sein. Der Arbeitgeber/Betreiber ist verpflichtet, Arbeitsstätten, bei denen ein 

besonderes Risiko einer Strahlenexposition besteht, zu beurteilen und zu 

kennzeichnen und mögliche Gefahren abzuwenden. 

6. Im Falle eines Brandes entweichen ggf. giftige Stoffe (Gase, Flüssigkeiten 

etc.) aus dem Produkt, die Gesundheitsschäden verursachen können. Daher 

sind im Brandfall geeignete Maßnahmen wie z.B. Atemschutzmasken und 

Schutzkleidung zu verwenden. 

7. Falls ein Laser-Produkt in ein R&S-Produkt integriert ist (z.B. CD/DVD-

Laufwerk), dürfen keine anderen Einstellungen oder Funktionen verwendet 

werden, als in der Produktdokumentation beschrieben, um Personenschäden 

zu vermeiden (z.B. durch Laserstrahl). 

8. EMV Klassen (nach EN 55011 / CISPR 11; sinngemäß EN 55022 / CISPR 22, 

EN 55032 / CISPR 32) 

Gerät der Klasse A: 

Ein Gerät, das sich für den Gebrauch in allen anderen Bereichen außer dem 

Wohnbereich und solchen Bereichen eignet, die direkt an ein 

Niederspannungs-Versorgungsnetz angeschlossen sind, das Wohngebäude 

versorgt. 

Hinweis: Diese Einrichtung kann wegen möglicher auftretender 

leitungsgebundener als auch gestrahlten Störgrößen im Wohnbereich 

Funkstörungen verursachen. In diesem Fall kann vom Betreiber verlangt 

werden, angemessene Maßnahmen durchzuführen. 
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Gerät der Klasse B: 

Ein Gerät, das sich für den Betrieb im Wohnbereich sowie in solchen 

Bereichen eignet, die direkt an ein Niederspannungs-Versorgungsnetz 

angeschlossen sind, das Wohngebäude versorgt. 

Reparatur und Service 

1. Das Produkt darf nur von dafür autorisiertem Fachpersonal geöffnet werden. 

Vor Arbeiten am Produkt oder Öffnen des Produkts ist dieses von der 

Versorgungsspannung zu trennen, sonst besteht das Risiko eines elektrischen 

Schlages.  

2. Abgleich, Auswechseln von Teilen, Wartung und Reparatur darf nur von R&S-

autorisierten Elektrofachkräften ausgeführt werden. Werden sicherheits-

relevante Teile (z.B. Netzschalter, Netztrafos oder Sicherungen) aus-

gewechselt, so dürfen diese nur durch Originalteile ersetzt werden. Nach 

jedem Austausch von sicherheitsrelevanten Teilen ist eine Sicherheitsprüfung 

durchzuführen (Sichtprüfung, Schutzleitertest, Isolationswiderstand-, 

Ableitstrommessung, Funktionstest). Damit wird sichergestellt, dass die 

Sicherheit des Produkts erhalten bleibt.  

Batterien und Akkumulatoren/Zellen 

Werden die Hinweise zu Batterien und Akkumulatoren/Zellen nicht oder 

unzureichend beachtet, kann dies Explosion, Brand und/oder schwere 

Verletzungen von Personen, unter Umständen mit Todesfolge, verursachen. Die 

Handhabung von Batterien und Akkumulatoren mit alkalischen Elektrolyten (z.B. 

Lithiumzellen) muss der EN 62133 entsprechen. 

1. Zellen dürfen nicht zerlegt, geöffnet oder zerkleinert werden.  

2. Zellen oder Batterien dürfen weder Hitze noch Feuer ausgesetzt werden. Die 

Lagerung im direkten Sonnenlicht ist zu vermeiden. Zellen und Batterien 

sauber und trocken halten. Verschmutzte Anschlüsse mit einem trockenen, 

sauberen Tuch reinigen. 

3. Zellen oder Batterien dürfen nicht kurzgeschlossen werden. Zellen oder 

Batterien dürfen nicht gefahrbringend in einer Schachtel oder in einem 

Schubfach gelagert werden, wo sie sich gegenseitig kurzschließen oder durch 

andere leitende Werkstoffe kurzgeschlossen werden können. Eine Zelle oder 

Batterie darf erst aus ihrer Originalverpackung entnommen werden, wenn sie 

verwendet werden soll. 

4. Zellen oder Batterien dürfen keinen unzulässig starken, mechanischen Stößen 

ausgesetzt werden. 
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5. Bei Undichtheit einer Zelle darf die Flüssigkeit nicht mit der Haut in Berührung 

kommen oder in die Augen gelangen. Falls es zu einer Berührung gekommen 

ist, den betroffenen Bereich mit reichlich Wasser waschen und ärztliche Hilfe 

in Anspruch nehmen. 

6. Werden Zellen oder Batterien, die alkalische Elektrolyte enthalten (z.B. 

Lithiumzellen), unsachgemäß ausgewechselt oder geladen, besteht 

Explosionsgefahr. Zellen oder Batterien nur durch den entsprechenden R&S-

Typ ersetzen (siehe Ersatzteilliste), um die Sicherheit des Produkts zu 

erhalten.  

7. Zellen oder Batterien müssen wiederverwertet werden und dürfen nicht in den 

Restmüll gelangen. Akkumulatoren oder Batterien, die Blei, Quecksilber oder 

Cadmium enthalten, sind Sonderabfall. Beachten Sie hierzu die landes-

spezifischen Entsorgungs- und Recycling-Bestimmungen.  

Transport 

1. Das Produkt kann ein hohes Gewicht aufweisen. Daher muss es vorsichtig 

und ggf. unter Verwendung eines geeigneten Hebemittels (z.B. Hubwagen) 

bewegt bzw. transportiert werden, um Rückenschäden oder Verletzungen zu 

vermeiden.  

2. Griffe an den Produkten sind eine Handhabungshilfe, die ausschließlich für 

den Transport des Produkts durch Personen vorgesehen ist. Es ist daher nicht 

zulässig, Griffe zur Befestigung an bzw. auf Transportmitteln, z.B. Kränen, 

Gabelstaplern, Karren etc. zu verwenden. Es liegt in Ihrer Verantwortung, die 

Produkte sicher an bzw. auf geeigneten Transport- oder Hebemitteln zu 

befestigen. Beachten Sie die Sicherheitsvorschriften des jeweiligen Herstellers 

eingesetzter Transport- oder Hebemittel, um Personenschäden und Schäden 

am Produkt zu vermeiden. 

3. Falls Sie das Produkt in einem Fahrzeug benutzen, liegt es in der alleinigen 

Verantwortung des Fahrers, das Fahrzeug in sicherer und angemessener 

Weise zu führen. Der Hersteller übernimmt keine Verantwortung für Unfälle 

oder Kollisionen. Verwenden Sie das Produkt niemals in einem sich bewe-

genden Fahrzeug, sofern dies den Fahrzeugführer ablenken könnte. Sichern 

Sie das Produkt im Fahrzeug ausreichend ab, um im Falle eines Unfalls 

Verletzungen oder Schäden anderer Art zu verhindern.  
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Entsorgung 

1. Batterien bzw. Akkumulatoren, die nicht mit dem Hausmüll entsorgt werden 

dürfen, darf nach Ende der Lebensdauer nur über eine geeignete 

Sammelstelle oder eine Rohde & Schwarz-Kundendienststelle entsorgt 

werden. 

2. Am Ende der Lebensdauer des Produktes darf dieses Produkt nicht über den 

normalen Hausmüll entsorgt werden, sondern muss getrennt gesammelt 

werden.  

Rohde & Schwarz GmbH & Co.KG ein Entsorgungskonzept entwickelt und 

übernimmt die Pflichten der Rücknahme- und Entsorgung für Hersteller 

innerhalb der EU in vollem Umfang. Wenden Sie sich bitte an Ihre 

Rohde & Schwarz-Kundendienststelle, um das Produkt umweltgerecht zu 

entsorgen. 

3. Werden Produkte oder ihre Bestandteile über den bestimmungsgemäßen 

Betrieb hinaus mechanisch und/oder thermisch bearbeitet, können ggf. 

gefährliche Stoffe (schwermetallhaltiger Staub wie z.B. Blei, Beryllium, Nickel) 

freigesetzt werden. Die Zerlegung des Produkts darf daher nur von speziell 

geschultem Fachpersonal erfolgen. Unsachgemäßes Zerlegen kann 

Gesundheitsschäden hervorrufen. Die nationalen Vorschriften zur Entsorgung 

sind zu beachten. 

4. Falls beim Umgang mit dem Produkt Gefahren- oder Betriebsstoffe entstehen, 

die speziell zu entsorgen sind, z.B. regelmäßig zu wechselnde Kühlmittel oder 

Motorenöle, sind die Sicherheitshinweise des Herstellers dieser Gefahren- 

oder Betriebsstoffe und die regional gültigen Entsorgungsvorschriften 

einzuhalten. Beachten Sie ggf. auch die zugehörigen speziellen 

Sicherheitshinweise in der Produktdokumentation. Die unsachgemäße 

Entsorgung von Gefahren- oder Betriebsstoffen kann zu Gesundheitsschäden 

von Personen und Umweltschäden führen. 

Weitere Informationen zu Umweltschutz finden Sie auf der Rohde & Schwarz 

Home Page. 
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Consignes de sécurité fondamentales 

Lisez et respectez impérativement les instructions et consignes de sécurité 

suivantes 

Les usines et sites du groupe Rohde & Schwarz veillent à la conformité des 

produits du groupe avec les normes de sécurité en vigueur dans un souci 

constant de garantir aux clients le plus haut niveau de sécurité possible. Nos 

produits ainsi que les accessoires nécessaires sont fabriqués et testés 

conformément aux règles de sécurité en vigueur. Le respect de ces règles est 

vérifié régulièrement par notre système d’assurance qualité. Le présent produit a 

été fabriqué et contrôlé conformément au certificat de conformité CE ci-joint et a 

quitté l’usine dans un parfait état de sécurité. Pour le maintenir dans cet état et en 

garantir une utilisation sans danger, l’utilisateur doit respecter l’ensemble des 

consignes, remarques de sécurité et avertissements qui se trouvent dans ce 

manuel. Le groupe Rohde & Schwarz se tient à votre disposition pour toutes 

questions relatives aux présentes consignes de sécurité. 

Il incombe à l’utilisateur d’employer ce produit de manière appropriée. Le produit 

est exclusivement destiné à l’utilisation en industrie et en laboratoire et/ou, si cela 

a été expressément autorisé, également aux travaux extérieurs ; il ne peut en 

aucun cas être utilisé à des fins pouvant causer des dommages corporels ou 

matériels. L’exploitation du produit en dehors de son utilisation prévue ou le non-

respect des consignes du fabricant se font sous la responsabilité de l’utilisateur. 

Le fabricant décline toute responsabilité en cas d’utilisation non conforme du 

produit.  

Le produit est présumé faire l’objet d’une utilisation conforme lorsqu’il est utilisé 

conformément aux consignes de la documentation produit correspondante et 

dans la limite de ses performances (voir fiche technique, documentation, 

consignes de sécurité ci-après). L’utilisation du produit exige des compétences 

en la matière et des connaissances de base de l’anglais. Par conséquent, le 

produit ne devra être utilisé que par un personnel qualifié ou des personnes 

formées de manière approfondie et possédant les compétences requises. Si, 

pour l’utilisation des produits Rohde & Schwarz, l’emploi d’un équipement 

personnel de protection s’avère nécessaire, il en est fait mention dans la 

documentation produit à l’emplacement correspondant. Conservez les consignes 

de sécurité fondamentales et la documentation produit dans un lieu sûr et 

transmettez ces documents aux autres utilisateurs du produit. 



Consignes de sécurité fondamentales 

1171.0000.53 – 08 Page 2 

La stricte observation des consignes de sécurité a pour but d’exclure des 

blessures ou dommages causés par des dangers de toutes sortes. A cet effet, il 

est nécessaire de lire avec soin et de bien comprendre les consignes de sécurité 

ci-dessous avant l’utilisation du produit et de les respecter lors de l’utilisation du 

produit. Toutes les autres consignes de sécurité présentées à l’emplacement 

correspondant de la documentation produit, par exemple, celles concernant la 

protection des personnes, doivent également être impérativement respectées. 

Dans les présentes consignes de sécurité, toutes les marchandises 

commercialisées par le groupe Rohde & Schwarz, notamment les appareils, les 

systèmes ainsi que les accessoires, sont dénommés « produit ». 

Symboles et marquages de sécurité 
 

Symbole Signification Symbole Signification 

 

Avis, source générale de danger 

Se référer à la documentation 
produit 

    MARCHE / ARRET (tension 
d’alimentation)  

 

Attention lors de la manipulation 
d’appareils ayant un poids élevé  

Indicateur de veille 

 

Risque de choc électrique  Courant continu (CC) 

 

Avertissement, surface chaude  Courant alternatif (CA) 

 

Borne de conducteur de protection  Courant continu/alternatif (CC/CA) 

 

Borne de mise à la terre 
 

L’appareil est conforme aux 
exigences de sécurité du degré de 
protection II 
(appareil entièrement protégé par 
isolation double/renforcée). 

 

Borne de mise à la masse du bâti 
ou du boîtier 

 

Marquage UE pour batteries et 
accumulateurs. 

L’appareil contient une batterie ou 
un accumulateur. Ces pièces ne 
peuvent pas être éliminées avec 
les déchets urbains non triés, 
mais doivent faire l’objet d’une 
collecte séparée. 

Pour plus d’informations, voir la 
page 7. 
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Symbole Signification Symbole Signification 

 

Avis : prudence lors de la 
manipulation de composants 
sensibles aux décharges 
électrostatiques 

 

Marquage UE pour la collecte 
séparée d’équipements 
électriques et électroniques. 

Les déchets d’équipements 
électriques et électroniques ne 
peuvent pas être éliminés avec les 
déchets urbains non triés, mais 
doivent faire l’objet d’une collecte 
séparée. 

Pour plus d’informations, voir la 
page 7. 

 

Avertissement, rayon laser 

Les produits laser sont munis 
d’avertissements normalisés 
d’après leur catégorie laser. 

En raison des caractéristiques de 
leur rayonnement ainsi que de 
leur puissance électromagnétique 
extrêmement concentrée, les 
lasers peuvent causer des 
dommages biologiques. 

Pour plus d’informations, voir le 
chapitre « Fonctionnement »", 
point 7. 

  



Consignes de sécurité fondamentales 

1171.0000.53 – 08 Page 4 

Mots d’alerte et significations 

Les mots d’alerte suivants sont utilisés dans la documentation produit pour avertir 

des risques et dangers. 

 

Indique une situation dangereuse immédiate qui, si 

elle n’est pas évitée, comporte un risque élevé de 

blessures graves ou mortelles. 

 

Indique une situation dangereuse possible qui, si 

elle n’est pas évitée, comporte un risque modéré 

de blessures (graves) ou mortelles. 

 

Indique une situation dangereuse qui, si elle n’est 

pas évitée, comporte un risque faible de blessures 

mineures ou modérées. 

 

Indique la possibilité d’une fausse manœuvre 

susceptible d’endommager le produit. 

Ces mots d’alerte correspondent à la définition habituelle utilisée pour des 

applications civiles dans l’espace économique européen. Des définitions 

divergentes peuvent cependant exister dans d’autres espaces économiques ou 

dans le cadre d’applications militaires. Il faut donc veiller à ce que les mots 

d’alerte décrits ici ne soient utilisés qu’en relation avec la documentation produit 

correspondante et seulement avec le produit correspondant. L’utilisation des 

mots d’alerte en relation avec des produits ou des documentations non 

correspondants peut conduire à des erreurs d’interprétation et par conséquent à 

des dommages corporels ou matériels. 
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États et positions de fonctionnement 

L’appareil ne doit être utilisé que dans les états et positions de fonctionnement 

indiqués par le fabricant. Tout obstacle à la ventilation doit être empêché. Le non-

respect des indications du fabricant peut provoquer des chocs électriques, des 

incendies et/ou des blessures graves pouvant éventuellement entraîner la mort. 

Pour tous les travaux, les règles locales et/ou nationales de sécurité et de 

prévention des accidents doivent être respectées.  

1. Sauf stipulations contraires, les produits Rohde & Schwarz répondent aux 

exigences ci-après :  

faire fonctionner le produit avec le fond du boîtier toujours en bas, degré de 

protection IP 2X, degré de pollution 2, catégorie de surtension 2, utilisation 

uniquement à l’intérieur, fonctionnement à une altitude max. de 2000 m au-

dessus du niveau de la mer, transport à une altitude max. de 4500 m au-

dessus du niveau de la mer, tolérance de ±10 % pour la tension nominale et 

de ±5 % pour la fréquence nominale. 

2. Ne jamais placer le produit sur des surfaces, véhicules, dépôts ou tables non 

appropriés pour raisons de stabilité ou de poids. Suivre toujours strictement 

les indications d’installation du fabricant pour le montage et la fixation du 

produit sur des objets ou des structures (par exemple parois et étagères). En 

cas d’installation non conforme à la documentation produit, il y a risque de 

blessures, voire de mort. 

3. Ne jamais placer le produit sur des dispositifs générant de la chaleur (par 

exemple radiateurs et appareils de chauffage soufflants). La température 

ambiante ne doit pas dépasser la température maximale spécifiée dans la 

documentation produit ou dans la fiche technique. Une surchauffe du produit 

peut provoquer des chocs électriques, des incendies et/ou des blessures 

graves pouvant éventuellement entraîner la mort. 

Sécurité électrique 

Si les consignes relatives à la sécurité électrique ne sont pas ou sont 

insuffisamment respectées, il peut s’ensuivre des chocs électriques, des 

incendies et/ou des blessures graves pouvant éventuellement entraîner la mort.  

1. Avant chaque mise sous tension du produit, il faut s’assurer que la tension 

nominale réglée sur le produit correspond à la tension nominale du réseau 

électrique. S’il est nécessaire de modifier le réglage de la tension, il faut 

remplacer le fusible du produit, le cas échéant.  

2. L’utilisation des produits du degré de protection I pourvus d’un câble 

d’alimentation mobile et d’un connecteur n’est autorisée qu’avec des prises 

munies d’un contact de protection et d’un conducteur de protection raccordé. 
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3. Toute déconnexion intentionnelle du conducteur de protection, dans le câble 

ou dans le produit lui-même, est interdite. Elle entraîne un risque de choc 

électrique au niveau du produit. En cas d’utilisation de câbles prolongateurs 

ou de multiprises, ceux-ci doivent être examinés régulièrement quant à leur 

état de sécurité technique. 

4. Si le produit n’est pas doté d’un interrupteur d’alimentation pour le couper du 

réseau électrique ou si l’interrupteur d’alimentation disponible n’est pas 

approprié pour couper le produit du réseau électrique, le connecteur mâle du 

câble de raccordement est à considérer comme dispositif de séparation. 

Le dispositif de séparation doit être à tout moment facilement accessible. Si, 

par exemple, le connecteur d’alimentation sert de dispositif de séparation, la 

longueur du câble de raccordement ne doit pas dépasser 3 m. 

Les commutateurs fonctionnels ou électroniques ne sont pas appropriés pour 

couper l’appareil du réseau électrique. Si des produits sans interrupteur 

d’alimentation sont intégrés dans des bâtis ou systèmes, le dispositif de 

séparation doit être reporté au niveau du système. 

5. Ne jamais utiliser le produit si le câble d’alimentation est endommagé. Vérifier 

régulièrement le parfait état du câble d’alimentation. Prendre les mesures 

préventives appropriées et opter pour des types de pose tels que le câble 

d’alimentation ne puisse pas être endommagé et que personne ne puisse 

subir de préjudice, par exemple en trébuchant sur le câble ou par des chocs 

électriques.  

6. L’utilisation des produits est uniquement autorisée sur des réseaux 

d’alimentation de type TN/TT protégés par des fusibles d’une intensité max. 

de 16 A (pour toute intensité supérieure, consulter le groupe 

Rohde & Schwarz). 

7. Ne pas brancher le connecteur dans des prises d’alimentation sales ou 

poussiéreuses. Enfoncer fermement le connecteur jusqu’au bout de la prise. 

Le non-respect de cette mesure peut provoquer des étincelles, incendies et/ou 

blessures. 

8. Ne pas surcharger les prises, les câbles prolongateurs ou les multiprises, cela 

pouvant provoquer des incendies ou chocs électriques. 

9. En cas de mesures sur les circuits électriques d’une tension efficace > 30 V, 

prendre les précautions nécessaires pour éviter tout risque (par exemple 

équipement de mesure approprié, fusibles, limitation de courant, coupe-circuit, 

isolation, etc.). 
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10. En cas d’interconnexion avec des équipements informatiques comme par 

exemple un PC ou un ordinateur industriel, veiller à ce que ces derniers soient 

conformes aux normes IEC 60950-1 / EN 60950-1 ou IEC 61010-1 / EN 

61010-1 en vigueur. 

11. Sauf autorisation expresse, il est interdit de retirer le couvercle ou toute autre 

pièce du boîtier lorsque le produit est en cours de service. Les câbles et 

composants électriques seraient ainsi accessibles, ce qui peut entraîner des 

blessures, des incendies ou des dégâts sur le produit. 

12. Si un produit est connecté de façon stationnaire, établir avant toute autre 

connexion le raccordement du conducteur de protection local et du conducteur 

de protection du produit. L’installation et le raccordement ne peuvent être 

effectués que par un électricien ou électronicien qualifié. 

13. Sur les appareils stationnaires sans fusible ni disjoncteur automatique ou 

dispositif de protection similaire intégrés, le circuit d’alimentation doit être 

sécurisé de sorte que toutes les personnes ayant accès au produit et le 

produit lui-même soient suffisamment protégés contre tout dommage. 

14. Chaque produit doit être protégé de manière appropriée contre les éventuelles 

surtensions (par exemple dues à un coup de foudre). Sinon, les utilisateurs 

sont exposés à des risques de choc électrique. 

15. Ne jamais introduire d’objets non prévus à cet effet dans les ouvertures du 

boîtier, étant donné que cela peut entraîner des courts-circuits dans le produit 

et/ou des chocs électriques, incendies ou blessures. 

16. Sauf spécification contraire, les produits ne sont pas protégés contre 

l’infiltration de liquides, voir aussi la section « États et positions de 

fonctionnement », point 1. Il faut donc protéger les produits contre l’infiltration 

de liquides. La non-observation de cette consigne entraîne le risque de choc 

électrique pour l’utilisateur ou d’endommagement du produit, ce qui peut 

également mettre les personnes en danger. 

17. Ne pas utiliser le produit dans des conditions pouvant occasionner ou ayant 

déjà occasionné, le cas échéant, des condensations dans ou sur le produit, 

par exemple lorsque celui-ci est déplacé d’un environnement froid dans un 

environnement chaud. L’infiltration d’eau augmente le risque de choc 

électrique. 

18. Avant le nettoyage, débrancher le produit de l’alimentation (par exemple 

réseau électrique ou batterie). Pour le nettoyage des appareils, utiliser un 

chiffon doux non pelucheux. N’utiliser en aucun cas de produit de nettoyage 

chimique, tel que de l’alcool, de l’acétone ou un diluant nitrocellulosique. 
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Fonctionnement 

1. L’utilisation du produit exige une formation spécifique ainsi qu’une grande 

concentration. Il est impératif que les personnes qui utilisent le produit présent 

les aptitudes physiques, mentales et psychiques requises, vu qu’autrement 

des dommages corporels ou matériels ne peuvent pas être exclus. Le choix 

du personnel qualifié pour l’utilisation du produit est sous la responsabilité de 

l’employeur/l’exploitant. 

2. Avant de déplacer ou de transporter le produit, lire et respecter la section 

« Transport ». 

3. Comme pour tous les biens produits de façon industrielle, l’utilisation de 

matériaux pouvant causer des allergies (allergènes, comme par exemple le 

nickel) ne peut être totalement exclue. Si, lors de l’utilisation de produits 

Rohde & Schwarz, des réactions allergiques surviennent, telles qu’éruption 

cutanée, éternuements fréquents, rougeur de la conjonctive ou difficultés 

respiratoires, il faut immédiatement consulter un médecin pour en clarifier la 

cause et éviter toute atteinte à la santé.  

4. Avant le traitement mécanique et/ou thermique ou le démontage du produit, il 

faut impérativement observer la section « Élimination des déchets », point 1. 

5. Selon les fonctions, certains produits, tels que des systèmes de 

radiocommunication RF, peuvent produire des niveaux élevés de 

rayonnement électromagnétique. Étant donné la vulnérabilité de l’enfant à 

naître, les femmes enceintes doivent être protégées par des mesures 

appropriées. Les porteurs de stimulateurs cardiaques peuvent également être 

menacés par les rayonnements électromagnétiques. L’employeur/l’exploitant 

est tenu d’évaluer et de repérer les lieux de travail soumis à un risque 

particulier d’exposition aux rayonnements et de prévenir les dangers 

éventuels. 

6. En cas d’incendie, il se peut que le produit dégage des matières toxiques 

(gaz, liquides, etc.) susceptibles de nuire à la santé. Il faut donc, en cas 

d’incendie, prendre des mesures adéquates comme par exemple le port de 

masques respiratoires et de vêtements de protection. 

7. Si un produit laser est intégré dans un produit Rohde & Schwarz (par exemple 

lecteur CD/DVD), il ne faut pas utiliser de réglages ou fonctions autres que 

ceux décrits dans la documentation produit pour éviter tout dommage corporel 

(par exemple causé par rayon laser). 

8. Classes CEM (selon EN 55011 / CISPR 11 ; selon EN 55022 / CISPR 22, EN 

55032 / CISPR 32 par analogie) 
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 Appareil de la classe A :  

Appareil approprié à un usage dans tous les environnements autres que 

l’environnement résidentiel et les environnements raccordés directement à 

un réseau d’alimentation basse tension qui alimente des bâtiments 

résidentiels.  

Remarque : ces appareils peuvent provoquer des perturbations 

radioélectriques dans l’environnement résidentiel en raison de 

perturbations conduites ou rayonnées. Dans ce cas, on peut exiger que 

l’exploitant mette en œuvre de mesures appropriées pour éliminer ces 

perturbations. 

 Appareil de la classe B : 

Appareil approprié à un usage dans l’environnement résidentiel ainsi que 

dans les environnements raccordés directement à un réseau d’alimentation 

basse tension qui alimente des bâtiments résidentiels. 

Réparation et service après-vente 

1. Le produit ne doit être ouvert que par un personnel qualifié et autorisé. Avant 

de travailler sur le produit ou de l’ouvrir, il faut le couper de la tension 

d’alimentation ; sinon il y a risque de choc électrique.  

2. Les travaux d’ajustement, le remplacement des pièces, la maintenance et la 

réparation ne doivent être effectués que par des électroniciens qualifiés et 

autorisés par Rohde & Schwarz. En cas de remplacement de pièces 

concernant la sécurité (notamment interrupteur d’alimentation, transformateur 

d’alimentation réseau ou fusibles), celles-ci ne doivent être remplacées que 

par des pièces d’origine. Après chaque remplacement de pièces concernant la 

sécurité, une vérification de sécurité doit être effectuée (contrôle visuel, 

vérification du conducteur de protection, mesure de la résistance d’isolement 

et du courant de fuite, essai de fonctionnement). Cela permet d’assurer le 

maintien de la sécurité du produit.  

Batteries et accumulateurs/cellules 

Si les instructions concernant les batteries et accumulateurs/cellules ne sont pas 

ou sont insuffisamment respectées, cela peut provoquer des explosions, des 

incendies et/ou des blessures graves pouvant entraîner la mort. La manipulation 

de batteries et accumulateurs contenant des électrolytes alcalins (par exemple 

cellules de lithium) doit être conforme à la norme EN 62133. 

1. Les cellules ne doivent être ni démontées, ni ouvertes, ni réduites en 

morceaux.  
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2. Ne jamais exposer les cellules ou batteries à la chaleur ou au feu. Ne pas les 

stocker dans un endroit où elles sont exposées au rayonnement direct du 

soleil. Tenir les cellules et batteries au sec. Nettoyer les raccords sales avec 

un chiffon sec et propre. 

3. Ne jamais court-circuiter les cellules ou batteries. Les cellules ou batteries ne 

doivent pas être gardées dans une boîte ou un tiroir où elles peuvent se court-

circuiter mutuellement ou être court-circuitées par d’autres matériaux 

conducteurs. Une cellule ou batterie ne doit être retirée de son emballage 

d’origine que lorsqu’on l’utilise. 

4. Les cellules ou batteries ne doivent pas être exposées à des chocs 

mécaniques de force non admissible. 

5. En cas de manque d’étanchéité d’une cellule, le liquide ne doit pas entrer en 

contact avec la peau ou les yeux. S’il y a contact, rincer abondamment à l’eau 

l’endroit concerné et consulter un médecin. 

6. Il y a danger d’explosion en cas de remplacement ou chargement incorrect 

des cellules ou batteries qui contiennent des électrolytes alcalins (par exemple 

cellules de lithium). Remplacer les cellules ou batteries uniquement par le type 

Rohde & Schwarz correspondant (voir la liste des pièces de rechange) pour 

maintenir la sécurité du produit.  

7. Il faut recycler les cellules ou batteries et il est interdit de les éliminer comme 

déchets normaux. Les accumulateurs ou batteries qui contiennent du plomb, 

du mercure ou du cadmium sont des déchets spéciaux. Observer les règles 

nationales d’élimination et de recyclage.  

Transport 

1. Le produit peut avoir un poids élevé. Il faut donc le déplacer ou le transporter 

avec précaution et en utilisant le cas échéant un moyen de levage approprié 

(par exemple, chariot élévateur) pour éviter des dommages au dos ou des 

blessures.  

2. Les poignées des produits sont une aide de manipulation exclusivement 

réservée au transport du produit par des personnes. Il est donc proscrit 

d’utiliser ces poignées pour attacher le produit à ou sur des moyens de 

transport, tels que grues, chariots et chariots élévateurs, etc. Vous êtes 

responsable de la fixation sûre des produits à ou sur des moyens de transport 

et de levage appropriés. Observer les consignes de sécurité du fabricant des 

moyens de transport ou de levage utilisés pour éviter des dommages 

corporels et des dégâts sur le produit. 
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3. L’utilisation du produit dans un véhicule se fait sous l’unique responsabilité du 

conducteur qui doit piloter le véhicule de manière sûre et appropriée. Le 

fabricant décline toute responsabilité en cas d’accidents ou de collisions. Ne 

jamais utiliser le produit dans un véhicule en mouvement si cela pouvait 

détourner l’attention du conducteur. Sécuriser suffisamment le produit dans le 

véhicule pour empêcher des blessures ou dommages de tout type en cas 

d’accident.  

Élimination des déchets 

1. Au terme de leur durée de vie, les batteries ou accumulateurs qui ne peuvent 

pas être éliminés avec les déchets ménagers peuvent uniquement être 

éliminés par des points de collecte appropriés ou par un centre de service 

après-vente Rohde & Schwarz. 

2. Au terme de sa durée de vie, un produit ne peut pas être éliminé avec les 

déchets ménagers normaux, mais doit être collecté séparément. 

Rohde & Schwarz GmbH & Co. KG a développé un concept d’élimination des 

déchets et assume toutes les obligations en matière de reprise et 

d’élimination, valables pour les fabricants au sein de l’UE. Veuillez vous 

adresser à votre centre de service après-vente Rohde & Schwarz pour 

éliminer le produit de manière écologique.  

3. Si les produits ou leurs composants sont travaillés mécaniquement et/ou 

thermiquement au-delà de l’utilisation prévue, ils peuvent, le cas échéant, 

libérer des substances dangereuses (poussières contenant des métaux lourds 

comme par exemple du plomb, du béryllium ou du nickel). Le démontage du 

produit ne doit donc être effectué que par un personnel qualifié et 

spécialement formé. Le démontage inadéquat peut nuire à la santé. Les 

règles nationales concernant l’élimination des déchets doivent être observées. 

4. Si, lors de l’utilisation du produit, des substances dangereuses ou 

combustibles exigeant une élimination spéciale sont dégagées, comme par 

exemple liquides de refroidissement ou huiles moteurs qui sont à changer 

régulièrement, les consignes de sécurité du fabricant de ces substances 

dangereuses ou combustibles ainsi que les règles sur l’élimination en vigueur 

au niveau régional doivent être respectées. Les consignes de sécurité 

spéciales correspondantes dans la documentation produit doivent également 

être respectées, le cas échéant. L’élimination non conforme des substances 

dangereuses ou combustibles peut provoquer des atteintes à la santé et des 

dommages écologiques. 

Pour plus d’informations concernant la protection de l’environnement, voir la page 

d’accueil de Rohde & Schwarz. 
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Customer Support 
Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer 
Support Centers. A team of highly qualified engineers provides telephone support and will 
work with you to find a solution to your query on any aspect of the operation, programming 
or applications of Rohde & Schwarz equipment. 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related 
to your instrument, please send an e-mail to the Customer Support Center stating your 
instrument and your wish. 
We will take care that you will get the right information. 
 
Europe, Africa, Middle East Phone   +49 89 4129 12345 

customersupport@rohde-schwarz.com

North America Phone   1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone   +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone   +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone   +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com

mailto:customersupport.china@rohde-schwarz.com
mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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1 Preface
The R&S SGU is an upconverter in the frequency range of 10 MHz to 40 GHz.

Optimized for use in automated test equipment (ATE), the instrument offers very
fast settling times in an exceptionally small form factor and low power consump-
tion. The R&S SGU has LO connectors for coupling multiple generators to a com-
mon LO source and can be equipped with a mechanical step attenuator.

1.1 Key Features

The key features of the R&S SGU include the following:

● Compact size and low power consumption
● Remote connection via PCI Express, minimizing time for setup

Alternatively, LAN or USB connections available
● Coherent LO input and output connectors, also usable as MIMO input/output

and phase coherent I/Q demodulation
● Linux operating system
● Graphical user interface R&S SGMA-GUI to set up and control one or more

R&S SGU instruments simultaneously from one remote computer, available
for Windows and Linux systems

1.2 Documentation Overview

The user documentation for the R&S SGU consists of the following parts:

● "Getting Started" printed manual
● Documentation CD-ROM with:

– Online help system (*.chm) as a standalone help
– User Manual for base unit and options
– Service manual
– Data sheet and product brochure
– Links to useful sites on the R&S internet

 

 

 

Key Features
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R&S SGMA-GUI Online Help

The Online Help is embedded in the R&S SGMA-GUI software. It offers quick,
context-sensitive access to the complete information needed for operation and
programming. The online help contains help on operating the R&S SGU and all
available options.

Getting Started

This manual is delivered with the instrument in printed form and in PDF format on
the Documentation CD-ROM. It provides the information needed to set up and
start working with the instrument. Basic operations and typical measurement
examples are described. The manual includes also general information, e.g.,
safety instructions.

User Manual

The User Manual is a supplement to the Getting Started manual. The manual is
available in PDF format - in printable form - on the Documentation CD-ROM deliv-
ered with the instrument. In this manual, all instrument functions are described in
detail. Furthermore, it provides an introduction to remote control and a complete
description of the remote control commands with programming examples. Infor-
mation on maintenance, instrument interfaces and error messages is also given.

Service Manual

The Service Manual is available in PDF format - in printable form - on the docu-
mentation CD-ROM delivered with the instrument. It informs on how to check
compliance with rated specifications, on instrument function, repair, troubleshoot-
ing and fault elimination. It contains all information required for repairing the
instrument by the replacement of modules.

Web Help

The content of the web helps correspond to the user manual for the latest product
version.

The web help is an additional file format that offers quick online access. This for-
mat is not intended for download but rather for accessing the required information
directly form the R&S website.

Web helps are available at the R&S website, on the R&S SGU product page at
http://www2.rohde-schwarz.com/product/SGU100A.html > Download > Web Help.

Documentation Overview

http://www2.rohde-schwarz.com/product/SGU100A.html
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1.3 Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface
elements"

All names of graphical user interface elements on the screen,
such as dialog boxes, menus, options, buttons, and softkeys are
enclosed by quotation marks.

KEYS Key names are written in capital letters.

File names, commands,
program code

File names, commands, coding samples and screen output are
distinguished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by
quotation marks.

 

Typographical Conventions
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2 Preparing for Use
● Putting into Operation....................................................................................... 8
● Linux Operating System..................................................................................16
● Connecting an External PC and Devices........................................................ 16

2.1 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S SGU
for the first time.

Risk of injury and instrument damage
The instrument must be used in an appropriate manner to prevent electric
shock, fire, personal injury, or damage.
● Do not open the instrument casing.
● Read and observe the "Basic Safety Instructions" at the beginning of

this manual or on the documentation CD-ROM, in addition to the safety
instructions in the following sections. Notice that the data sheet may
specify additional operating conditions.

Risk of instrument damage
Note that the general safety instructions also contain information on operat-
ing conditions that will prevent damage to the instrument. The instrument's
data sheet may contain additional operating conditions.
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Risk of electrostatic discharge (ESD)
Electrostatic discharge (ESD) can cause damage to the electronic compo-
nents of the instrument and the device under test (DUT). ESD is most likely
to occur when you connect or disconnect a DUT or test fixture to the instru-
ment's test ports. To prevent ESD, use a wrist strap and cord and connect
yourself to the ground, or use a conductive floor mat and heel strap combi-
nation.
For details, refer to the safety instructions delivered in electronic format on
the documentation CD-ROM.

Risk of instrument damage during operation
An unsuitable operating site or test setup can cause damage to the instru-
ment and to connected devices. Ensure the following operating conditions
before you switch on the instrument:
● All fan openings are unobstructed and the airflow perforations are unim-

peded. The minimum distance from the wall is 10 cm.
● The instrument is dry and shows no sign of condensation.
● The instrument is positioned as described in the following sections.
● The ambient temperature does not exceed the range specified in the

data sheet.
● Signal levels at the input connectors are all within the specified ranges.
● Signal outputs are correctly connected and are not overloaded.

2.1.1 EMI Suppression

Electromagnetic interference (EMI) may affect the measurement results.

To suppress generated Electromagnetic Interference (EMI),
● Use suitable shielded cables of high quality. For example use double-shielded

RF and LAN cables.
Note: USB cables are of varying and often poor quality. Therefore, check the
quality of each individual USB cable as described in the service manual.
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● Always terminate open cable ends.
● Note the EMC classification in the data sheet

2.1.2 Unpacking and Checking the Instrument

Check the equipment for completeness using the delivery note and the accessory
lists for the various items. Check the instrument for any damage. If there is dam-
age, immediately contact the carrier who delivered the instrument. Make sure not
to discard the box and packing material.

Packing material
Retain the original packing material. If the instrument needs to be transpor-
ted or shipped at a later date, you can use the material to protect the control
elements and connectors.

Risk of damage during transportation and shipment
Insufficient protection against mechanical and electrostatic effects during
transportation and shipment can damage the instrument.
● Always make sure that sufficient mechanical and electrostatic protection

is provided.
● When shipping an instrument, the original packaging should be used. If

you do not have the original packaging, use sufficient padding to pre-
vent the instrument from moving around inside the box. Pack the instru-
ment in antistatic wrap to protect it from electrostatic charging.

● Secure the instrument to prevent any movement and other mechanical
effects during transportation.

The carrying handles at the front and side of the casing are designed to lift
or carry the instrument. Do not apply an excessive external force to the
handles.
Observe the information on transporting heavy instruments in the basic
safety instructions included at the front of the printed manual and on the
supplied CD ROM.
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2.1.3 Accessory List

The instrument comes with the following accessories:

● Power cable
● Getting Started printed manual
● R&S SGU User Documentation CD-Rom

2.1.4 Placing or Mounting the Instrument

The R&S SGU is designed for use under laboratory conditions, either on a bench
top or in a rack using a rack adapter kit (order number see data sheet).

Bench Top Operation

If the R&S SGU is operated on a bench top, the surface should be flat. The instru-
ment can be used in horizontal position, standing on its feet.
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Risk of injury and instrument damage if stacking instruments
A stack of instruments may tilt over and cause injury. Furthermore, the
instruments at the bottom of the stack may be damaged due to the load
imposed by the instruments on top.
Observe the following instructions when stacking instruments:
● Never stack more than three instruments with the same dimensions

(width and length). If you need to stack more than three instruments,
install them in a rack.

● The overall load imposed on the lowest instrument must not exceed
500 N.

● All instruments should have the same dimensions (width and length).
If you need to stack smaller instruments on the top, the overall load
imposed on the lowest instrument must not exceed 250 N.

● If the instruments have foldable feet, fold them in completely.

Rackmounting

The R&S SGU can be installed in a rack using a rack adapter kit (Order No. see
data sheet). The installation instructions are part of the adapter kit.

Putting into Operation
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Risk of instrument damage in a rack
An insufficient airflow can cause the instrument to overheat, which may dis-
turb the operation and even cause damage.
Make sure that all fan openings are unobstructed, that the airflow perfora-
tions are unimpeded, and that the minimum distance from the wall is 10 cm.

2.1.5 Switching the Instrument On and Off

The R&S SGU is automatically adapted to the AC voltage supplied. There is no
need to set the voltage manually or change fuses. The AC SUPPLY AND
POWER SWITCH is at the rear of the unit.

To connect the AC supply

► Connect the R&S SGU to the AC power source using the AC power cable
delivered with the instrument.
Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

To start up the instrument

1. Connect the instrument to the AC supply.

2. To turn the power on, press the main power switch to position I (On).

To switch between standby and ready state

► Press the POWER ON /STAND BY key briefly to switch the instrument from
the standby to ready state or vice versa.
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In ready state, the button is green. The instrument is ready for operation. All
modules are power-supplied and the R&S SGU initiates its startup procedure.
In standby state, the button is orange. The standby power mode keeps the
power switch circuits and the remote control system active.

Start-up and booting

The instrument boots the operating system and starts the instrument firmware.
During the booting process the green POWER ON /STAND BY key blinks. If the
previous session was terminated regularly, the instrument uses the last setup with
the relevant instrument settings.

Once the startup procedure has been terminated, the instrument is ready for
operation.

In the R&S SGMA-GUI, select "Instrument > Preset" function to return the
instrument to its defined reset/preset state, if the current setup is no longer
relevant.

To customize the start settings, use the "SGMA-GUI > File > Save As/Open"
function.

To shut down the Instrument

To shut down the R&S SGU, proceed as described below.

Risk of losing data
If you switch off the running instrument using the rear panel switch or by
disconnecting the power cord, the instrument loses its current settings.
Always press the POWER ON/STANDBY key first to shut down the applica-
tion properly.

1. Press the POWER ON /STAND BY key to save the current setup, shut down
the operating system and set the instrument to standby state.
The POWER ON /STAND BY LED must be orange.

Putting into Operation
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Tip: If the instrument is operated manually via the R&S SGMA-GUI, select
"SGMA-GUI > Instrument Name > Setup > Standby".

2. To turn the power off, press the main power switch to position 0 (Off).

None of the front-panel LEDs should be on.

2.1.6 Function Check

The instrument automatically monitors the main functions when it is switched on
and monitors them continuously during operation.

A detected fault is indicated by an "Error" message displayed in the info line of
the R&S SGMA-GUI together with a brief error description. For an in-depth identi-
fication of the error, press the "SGMA-GUI > Info" button. In response, a descrip-
tion of the error(s) is displayed. For more information, refer to the "Error Mes-
sages" section in the User Manual.

2.1.7 Default Settings

When the instrument is switched on, it is not the preset state that is active, but
rather the instrument state that was set before the instrument was switched off. It
is recommended that you use the "SGMA-GUI > Instrument > Preset" function to
return the instrument to its defined preset state every time a new configuration is
required or the current setup is no longer relevant.

The R&S SGU offers a two-stage preset concept:
● Preset the instrument to a predefined state

The "SGMA-GUI > Instrument Name > Preset" function calls up a defined
instrument setup. All parameters and switching states are preset (also those
of inactive operating modes). The default instrument settings provide a repro-
ducible initial basis for all other settings. However, functions that concern the
integration of the instrument into a measurement setup are not changed.

● Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To
access the corresponding dialog box, select the "SGMA-GUI > Instrument
Name > Setup > Factory Preset" function.
For more information and an overview of the settings affected by the factory
preset function, see the "Factory Preset" section in the User Manual.
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User-defined instrument states can be stored and called up using the func-
tions "SGMA-GUI > File > Save As/Open".

2.2 Linux Operating System

The instrument uses an embedded Linux operating system, optimally adapted to
the instrument.

Accessing the Operating System
No access to the operating system is required for normal operation.
All necessary system settings can be made in the "Setup" dialog.

2.3 Connecting an External PC and Devices

As a rule, the R&S SGU is operated exclusively via remote control on a connec-
ted PC. Another way to control the instrument is the manual operation via the
R&S SGMA-GUI software on the connected PC.

Both the remote control and the manual operation of the instrument require an
external controller. For the prerequisites and the instructions on how to configure
an external controller for remote control, refer to the User Manual. A brief intro-
duction to the remote control capabilities is provided in chapter 5.2, "Network and
Remote Control Operation", on page 41.

This section gives an introduction on how to configure the external PC for manual
operation (see chapter 2.3.1, "Installing the R&S SGMA-GUI Software on an
External PC", on page 17).

In addition to connecting an external controller, it may be useful to connect other
external devices, e.g. a memory stick. The following interfaces are provided on
the rear panel of the instrument, see also chapter 3.2, "Rear Panel Tour",
on page 26:

● PCI Express (refer to chapter 2.3.3, "Connecting a Controller via PCI
Express", on page 21
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● USB interface (refer to chapter 2.3.4, "Connecting a Controller or an USB
Device via USB", on page 21)

● LAN interface (refer to chapter 2.3.2, "Connecting a Remote PC via LAN",
on page 19)

2.3.1 Installing the R&S SGMA-GUI Software on an External PC

The R&S SGMA-GUI is delivered in the latest version available on the CD-ROM
included in the instrument's delivery. Software updates as well as the Release
Notes describing the improvements and modifications are provided on the Inter-
net at the download site of the Rohde&Schwarz home page. This home page
always offers the latest information on your R&S SGMA-GUI.

The R&S SGMA-GUI software is provided as separate installation package
for the different operating systems.
This description focuses on the handling of the Windows-32 version. The
file naming conventions and the installation instructions for the other operat-
ing systems are analogous.

The R&S SGMA-GUI installation package for Windows-32 operating system con-
sists of the file SGMA-GUI_<V.VV.VVV.VVV>.exe. The version numbers in the
file names vary with each update. To install the R&S SGMA-GUI, the following
hardware and software requirements have to be met.
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Table 2-1: Hardware and Software Requirements

Requirement Remark

One of the following operating
systems:
● Windows XP SP2
● Windows Vista
● Windows 7
● Windows 8/ 8.1
● Linux

R&S SGMA-GUI has to be installed on one of the supported
operating systems.
Note:
Any other Windows version or other operating systems are
not supported.
Windows Installer Version 4.5 or higher is needed for the
installation of the software on a Windows XP computer.
During installation, the operation system is checked.
The installation will be terminated if this requirement is not ful-
filled.

National Instruments (NI) VISA
version 3.4.1 or higher
(optional)
or
Agilent VISA version 14 or
higher (optional)

VISA drivers can be obtained from R&S or NI directly.

CPU At least Pentium or compatible, as from 1 GHz (recommen-
ded).

VGA color display resolution At least 800*600 pixels

Installing a new software version

Administrator rights are necessary for installation and starting.

► In Windows Explorer double-click SGMA-GUI_V.VV.VVV.VVV.exe and fol-
low the instructions.

Uninstalling an old software version

An uninstallation of a previous version of the SW can be performed prior to the
installation of the new one but is not mandatory.

► To uninstall this version, go to "Start > Settings > Control Panel > Add/
Remove Programs" and select the entry SGMA-GUI_V.VV.VVV.VVV.

The script file identifies and removes all currently installed R&S SGMA-GUI
software items.

Connecting an External PC and Devices
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2.3.2 Connecting a Remote PC via LAN

The R&S SGU is equipped with a network interface and can be connected to an
Ethernet LAN (local area network). The interface can be used, for example:

● To connect an external computer for manual control of the instrument by
means of the R&S SGMA-GUI software.

● To operate the device by a remote control program.
See chapter 5.2, "Network and Remote Control Operation", on page 41.

This section describes how to configure the LAN interface. It includes the follow-
ing topics:

● chapter 2.3.2.1, "Connecting the Instrument to the Network", on page 19
● chapter 2.3.2.2, "Assigning the IP Address", on page 20
● chapter 2.3.2.3, "Automatically adding instruments to the SGMA-GUI ",

on page 20

2.3.2.1 Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

● A non-dedicated network (Ethernet) connection from the instrument to an
existing network.

● A dedicated network connection (Point-to-point connection) between the
instrument and a single computer.

In both cases, an IP address has to be assigned to the instrument and the com-
puter, see chapter 2.3.2.2, "Assigning the IP Address", on page 20.

Setting Up a Network (LAN) Connection

Risk of network failure
Before connecting the instrument to the network or configuring the network,
consult your network administrator. Errors may affect the entire network.

► Connect the instrument to the network or to a single PC.
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If the instrument is connected to the LAN, the operating system automatically
detects the network connection and activates the required drivers.
By default, the instrument is configured to use dynamic TCP/IP configuration
and obtain all address information automatically.

2.3.2.2 Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the
instrument can be obtained in different ways.
● If the network supports dynamic TCP/IP configuration using the Dynamic Host

Configuration Protocol (DHCP), all address information can be assigned auto-
matically.

● If the network does not support DHCP, the instrument tries to obtain the IP
address via Zeroconf (APIPA) protocol. If this attempt does not succeed or if
the instrument is set to use alternate TCP/IP configuration, the addresses
must be set manually.

The R&S SGU uses the Zeroconf IP addresses 169.254.xxx.yyy., where
xxx may take values between 1...254 and yyy the values in the value range
1...255; the subnet mask is always 255.255.0.0. The IP address of the host
must be within the same address area for Zeroconf.

By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically. This means that it is safe to establish
a physical connection to the LAN without any previous instrument configuration.

2.3.2.3 Automatically adding instruments to the SGMA-GUI

For information on how to install the R&S SGMA-GUI software, refer to
chapter 2.3.1, "Installing the R&S SGMA-GUI Software on an External PC",
on page 17.

1. For each new instrument perform the following steps:
a) Connect the instrument to the network.
b) Press the POWER ON /STAND BY key to switch on the instrument.
c) Wait until the POWER ON /STAND BY LED is green and not blinking.
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d) Press the ID key on the front panel of the instrument.

2. Start the SGMA-GUI on a computer connected to the same network.

3. Open the "Instruments" dialog and click "Scan".
Note: This step is performed automatically on the first start and can also be
omitted for instruments with a direct LAN connection to the computer.

All instruments will be added automatically to the main panel of the SIGMA-
GUI.

2.3.3 Connecting a Controller via PCI Express

A PCI Express connector is provided on the rear panel of the instrument, see
chapter 3.2, "Rear Panel Tour", on page 26.

Risk of device failure
The R&S SGU is equipped with a single lane PCIe interface that supports
hot plugging.
Do not connect an external PC to the PCIe connector of the instrument dur-
ing operation if this external PC does not support hot-plugging!

Using the PCIe interface for remote control of the instrument requires extended
knowledge and is described in section "Advanced Remote Control via PCIe" in
the User Manual.

2.3.4 Connecting a Controller or an USB Device via USB

The USB interface on the rear panel of the R&S SGU allows you to connect either
an USB device or use the R&S SGU as a device and connect it to a controller.

Connecting a controller (host PC or compatible signal generator)

If you connect a controller (host PC or compatible signal generator) to the
R&S SGU, the R&S SGU acts as an USB device.

To connect the controller to the USB interface of the R&S SGU, always connect
the USB Type Micro-B connector to the R&S SGU. Refer to the documentation
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of the controller to find out which USB connector type you can connect to the con-
troller.

The figure 2-1 illustrates schematically the required connector type to emphasize
on the different connector shape.

Fig. 2-1: USB Type Micro-B connectors

An external PC with installed R&S SGMA-GUI is required for manual operation of
the R&S SGU.

On the remote PC, perform the steps as described in chapter 2.3.2.3, "Automati-
cally adding instruments to the SGMA-GUI ", on page 20.

Connecting an USB device

If you connect an USB device (Memory stick, CD-ROM, an instrument) to the
R&S SGU, the R&S SGU acts as a host.

To connect an USB device to the interface of the R&S SGU, always connect the
USB Type Micro-A connector to the R&S SGU. Refer to the documentation of
the USB device to find out which USB connector type you can connect to the
USB device.

The figure 2-2 illustrates schematically the required connector type to emphasize
on the different connector shape.

Fig. 2-2: USB Type Micro-A connectors

If you connect an R&S SGS to an R&S SGU via an USB cable, perform the steps
as described in chapter "Setups for Connecting an R&S SGS and an R&S SGU"
of the User Manual.

Connecting an External PC and Devices
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Using an USB Adapter
You can use an USB adapter to customize the connectors of an USB cable
to the requirements of the instrument.
For example you can use a Type-A / Micro-A adapter to customize a stand-
ard USB cable with Type A and Type Micro-B connectors for the connection
of an R&S SGS (acting as a host) to an R&S SGU (acting as an USB
device).
In some cases you can also use a Type-A / Micro-B adapter to establish a
connection to the instrument. To check whether the adapter you have is
suitable or not you can connect an USB stick with an LED through the
adapter to the instrument. If the LED of the USB stick lights up after a con-
nection to the instrument then you can use this adapter for further applica-
tions with the instrument.

Connecting an External PC and Devices
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3 Instrument Tour
The following topics will help you get familiar with the instrument and perform the
first steps:
● Front Panel Tour
● Rear Panel Tour

This section explains the control elements and the connectors of the R&S SGU
with the aid of the front and rear views. Specifications of interfaces can be found
in the data sheet.

3.1 Front Panel Tour

This section provides an overview of control elements on the front panel of the
R&S SGU. The connectors of the R&S SGU are placed on the rear panel and are
described in chapter 3.2, "Rear Panel Tour", on page 26. As the R&S SGU is
mainly intended to be remote-controlled, the front panel of the R&S SGU contains
no display but mostly LEDs to inform the user about the status of the instrument.
The user interface can be displayed on a remote PC station used to manually
remote control the instrument.

Fig. 3-1: Front panel view

POWER ON /STAND BY

The POWER ON /STAND BY key switches the instrument from the standby to
ready state or vice versa.
In ready state, the button is green. The instrument is ready for operation.
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In standby state, the button is orange. In this state it is safe to switch off the AC
power and disconnect the instrument from the power supply.
A blinking green color indicates that a booting operation is in proccess.

RF ON

The RF ON key switches the RF signal on or off. If activated, the button is green.

LO IN

The LO IN LED indicates the compatibility of the level of the LO input signal with
the correct operation of the R&S SGU.
● Green indicates that the level of the LO input signal is in the range of correct

operation.
● Red indicates that the level of the LO input signal is too high or too low.
● No light indicates that the instrument is in a bypass mode.

ERROR / WARNING

The ERROR / WARNING LED indicates the status of the R&S SGU.
● Red indicates that an error has occurred, e.g. temperature exceeded or power

failure.
● Blinking orange indicates a running process (e.g calibration, self test).
● No light indicates that no errors or warnings have occurred.
For details on errors or warnings refer to the graphical user interface on a remote
PC ("SGMA-GUI > Info").
For more information, refer to the "Error Messages" section in the User Manual.

LAN

Front Panel Tour
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Pressing the key for more than 3 s resets the LAN interface settings, i.e the "IP
Adress Mode" is reset to DHCP.

ID

Pressing the ID key while the instrument is active,opens the "SGMA-GUI > Setup
> Instruments > Configure Instruments > Edit Instrument" dialog of the corre-
sponding instrument on the remote controller.
Pressing the ID key of an inactive instrument and starting "SGMA-GUI > Setup >
Instruments > Scan", leads to an automatic activation of the instrument in the
SGMA-GUI.

3.2 Rear Panel Tour

This section provides an overview of the connectors on the rear panel of the
instrument. For technical data of the connectors refer to the data sheet.

Fig. 3-2: Rear panel view

Protection of mechanical components
To avoid damage of the SMA connectors it is essential to limit the tightening
torque to 60 Ncm. Use an adequate 8 mm torque wrench and not an ordi-
nary open-end wrench.
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PCI EXPRESS CONNECTOR

The PCIe (Peripheral Component Interconnect Express) single lane interface
allows remote control with optimized speed.
For details see chapter 2.3.3, "Connecting a Controller via PCI Express",
on page 21.

USB CONNECTOR

The USB (universal serial bus) interface, Type Micro, allows you to connect vari-
ous external devices, e.g.:
● If the interface is configured as a device interface, a remote computer can be

connected for firmware update, manual operation via the R&S SGMA-GUI
software or for remote control of the instrument.

● If the interface is configured as a host interface, a memory stick for file trans-
mission can be connected.

For details see chapter 2.3.4, "Connecting a Controller or an USB Device via
USB", on page 21.

LAN CONNECTOR

The LAN (Ethernet) interface allows you to connect the R&S SGU to other devi-
ces, e.g. a remote computer, for firmware update, manual operation via the R&S
SGMA-GUI software or for remote control of the instrument. The connection to
the remote computer can be direct or via a network.
For details see chapter 2.3.2, "Connecting a Remote PC via LAN", on page 19.

Rear Panel Tour
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RF OUT

Provides an RF 50 Ohm signal output.
NOTICE! Maximum Input Levels. Do not overload the RF output. The maximum
permissible back-feed is specified in the data sheet.

LO IN, LO OUT

Connectors that can be used for local oscillator signals and alternatively also in
MIMO setups.
Local oscillator input and output:
● LO IN: Input for external LO signals
● LO OUT: Output of internal LO signals

TRIG

Multi purpose connector. The TRIG connector is used mainly as an input connec-
tor for an external pulse modulator source.

I, Q IN / OUT

The I IN and Q IN connectors are the inputs of the I/Q modulator, provided for
feeding of external signal.
The I OUT and Q OUT connectors are for direct output of the analog I/Q signal.
NOTICE! Maximum Input Levels. Do not overload the I and Q inputs. The maxi-
mum permissible voltage is 1V. For details, refer to the data sheet.
Note: The I/Q modulator requires the hardware optionR&S SGU-B120V/-B140V.

Rear Panel Tour
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AC SUPPLY AND POWER SWITCH

The AC supply and power switch allow you to connect the R&S SGU to the power
supply and switch on the instrument.
For details see "To connect the AC supply" on page 13.

Rear Panel Tour
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4 First steps with the Instrument
If an R&S SGU is connected to a signal generator, the instrument acts as an
extension to the signal generator extending its frequency range.

This section provides an example on how to configure the instrument to convert a
continuous wave (CW) signal.

4.1 R&S SGU as an Extension to the R&S SGS

In case the R&S SGU is connected to a compatible R&S signal generator, a con-
troller only needs to talk to the signal generator which in turn takes care of the
proper settings for the SGU.

In the following example the instrument is manually operated via the R&S SGMA-
GUI software. The R&S SGU in this example is a base unit equipped with the fre-
quency option R&S SGU-B120.

Configuring the the R&S SGU to upconvert a CW signal generated by the
R&S SGS

As a prerequisite for this example the R&S SGMA-GUI software has to be instal-
led on a remote PC.

Fig. 4-1: Example of a test setup for upconverting a CW signal generated by the R&S SGS
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For higher setting/ measuring speeds use a PCIe switch and a PCIe con-
nections.

1. Connect the test equipment as shown in figure 4-2:
a) Connect the R&S SGS, R&S SGU and the controller to a LAN switch.
b) Connect the RF OUT of the R&S SGS to the LO IN of the R&S SGU.
c) Connect the TRIG connectors of the R&S SGS and the R&S SGU.
d) Connect the RF OUT of the R&S SGU to the RF IN of the signal analyzer.

2. Switch on the R&S SGS and the R&S SGU.
The POWER ON/STANDBY keys have to be green and not blinking.

3. Press the ID keys on the front panels of the R&S SGS and the R&S SGU
(only required if the components are connected via a company network).

4. On the connected remote PC, start the R&S SGMA-GUI software application.
The main panel of the application and the configure instruments dialog open.
Both instruments are added automatically to the instruments list and to the
main panel of the R&S SGMA-GUI software.
The main panel provides a quick access to the main settings of the configured
and activated instruments. The display shows one row per instrument with the
instrument specific settings. The rows comprise the instrument, the connec-
tion state, the used frequency and power level and the state of the RF output
and the modulator.

R&S SGU as an Extension to the R&S SGS
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5. In the R&S SGMA-GUI main panel, the green indicator in front of the instru-
ment's name confirms that there is a connection between the instrument and
the remote PC and that the instrument is recognized by the software.

6. In the R&S SGMA-GUI main panel, select the rows corresponding to the cor-
responding instruments to be configured and select "Instrument Name > Pre-
set" to restore their predefined settings.

7. Select "SGMA-GUI main panel > R&S SGS > Extension".
The "Extension" dialog opens.

Tip: Instrument doesn't appear in the extension dialog. If the R&S SGU is not
automatically shown in this dialog press "Scan > Start" to find the instrument.

8. Select the R&S SGU from the list and set "Available Instruments > Select >
On" to enable it as an extension.
A green status indicator "Connected" indicates the successfully established
remote connection between the R&S SGS ant the R&S SGU.
The R&S SGMA-GUI indicates the extended frequency range of the R&S
SGS and the activated extension mode.

R&S SGU as an Extension to the R&S SGS
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9. Select "Test Signal Connections > Test" to trigger a check of all required sig-
nal connections.

The diagram displays the connection state of the tested connections.

R&S SGU as an Extension to the R&S SGS
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10.Select "SGMA-GUI > R&S SGS > Freq = 40 GHz", "Lev = -30 dBm".

11.Select "SGMA-GUI >SGS> RF > State > On" to enable the output of the CW
signal.

The extension adopts these values and states automatically and generates a
CW signal with RF = 40 GHz and Level = -20 dBm.

The signal is output at the RF OUT connector on the rear panel of the R&S
SGU.

Identifying a specific instrument
If several instruments are active in the R&S SGMA-GUI use one of the
device identification functions to identify a specific device:
● Select "SGMA-GUI > Instrument Name > Setup > Remote > Remote

Channels > Device Identify". The green LAN LED on the front panel of
the instrument blinks.

● Press the ID key on the instrument's front panel. The "Edit Instrument"
dialog of the respective instrument opens.

4.2 R&S SGU as a Standalone Upconverter

This section provides an example on how to configure the instrument to convert a
continuous wave (CW) signal. The signal in this example is provided by an incom-
patible signal generator (local oscillator).

In the following example the instrument is manually operated via the R&S SGMA-
GUI software. The R&S SGU in this example is a base unit equipped with the fre-
quency option R&S SGU-B120.
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Configuring the R&S SGU to convert a CW signal

As a prerequisite for this example the R&S SGMA-GUI software has to be instal-
led on a remote PC and the local oscillator has to be prepared for use.

Fig. 4-2: Example of a setup of the R&S SGU as an upconverter

1. Connect the test equipment as shown in figure 4-2. Additional connections
may be needed to fulfill the requirements of the connected local oscillator. To
find out what connections are needed refer to its user manual.

2. Switch on the R&S SGU.
The POWER ON/STANDBY key has to be green and not blinking.

3. Press the ID key on the front panel the R&S SGU (only required if the compo-
nents are connected via a company network).

4. On the connected remote PC, start the R&S SGMA-GUI software application.
The main panel of the application and the configure instruments dialog open.
The R&S SGU is added automatically to the instruments list and to the main
panel of the R&S SGMA-GUI software.
The main panel provides a quick access to the main settings of the configured
and activated instruments. The display shows one row per instrument with the
instrument specific settings. The rows comprise the instrument, the connec-
tion state, the used frequency and power level and the state of the RF output
and the modulator.

R&S SGU as a Standalone Upconverter
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5. In the R&S SGMA-GUI main panel, the green indicator in front of the instru-
ment's name confirms that there is a connection between the instrument and
the remote PC and that the instrument is recognized by the software.

6. In the R&S SGMA-GUI main panel, select the row corresponding to the instru-
ment to be configured and select "Instrument Name > Preset" to restore the
predefined instrument's settings.

7. Select "SGMA-GUI > R&S SGU > Freq = 15 GHz", "Lev = -10 dBm", "RF >
On".

8. Select "SGMA-GUI > Instrument Name >Ext. Local Oscillator". Read the
required frequency and level values for the LO.

R&S SGU as a Standalone Upconverter
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9. Change the settings of the LO to the required values.

10.Select "SGMA-GUI > Instrument Name > Ext. Local Oscillator > Confirm
External LO Settings" to apply the changes.

The 15 GHz signal is output at the LO OUT connector at the rear panel of the
R&S SGU.

Identifying a specific instrument
If several instruments are active in the R&S SGMA-GUI use one of the
device identification functions to identify a specific device:
● Select "SGMA-GUI > Instrument Name > Setup > Remote > Remote

Channels > Device Identify". The green LAN LED on the front panel of
the instrument blinks.

● Press the ID key on the instrument's front panel. The "Edit Instrument"
dialog of the respective instrument opens.

R&S SGU as a Standalone Upconverter
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5 Instrument Control
As a rule, the R&S SGU is operated exclusively via programmatic remote control
from a connected PC. For service and diagnostic tasks, as well as for manual
configuration, a graphical user interface (R&S SGMA-GUI) is provided which runs
on the remote PC.

Additionally, some basic functionality is provided via the keys on the front panel of
the instrument (see chapter 3.1, "Front Panel Tour", on page 24).

5.1 Manual Operation via R&S SGMA-GUI

The R&S SGMA-GUI software application can be installed on a PC with Windows
or Linux operating system. This program allows you to control several devices of
the SGMA product family at the same time and to monitor the device status dur-
ing remote control. R&S SGMA-GUI requires one of the external interfaces
described in chapter 2.3, "Connecting an External PC and Devices", on page 16.

5.1.1 Introduction to the User Interface

After the start of R&S SGMA-GUI the main dialog of the application is displayed.

The main dialog with an overview of the configured instruments is the operating
and control interface for the whole program. From here, all program functions are
accessible.

The menus and dialogs are built using elements like selection lists, check boxes,
and entry fields. A blue frame indicates that the selected item is active. Entries
can be made in the highlighted element.
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The main dialog comprises two main areas:
● On the top of the main panel, there are the menu bar, the tool bar and the info

bar with the corresponding "Info" button.
The menu bar provides access to the functions related to the software appli-
cation itself, like saving current configurations, resetting the display, retrieving
information about the installed software version or configuring the connected
instruments.
The messages displayed in the info line indicate information, warnings, and
errors. They are displayed in different colors depending on their importance
and display duration. Use the "Info" button to open a dialog with information
on the messages in greater detail.

● The central part of the R&S SGMA-GUI main dialog is the main panel that
shows the list of all active instruments.
The main panel is the core element for the manual operation and provides
quick access to the main settings of the configured instruments. The display
shows one row per active instrument. Each row comprises the instrument's
name and state, the used frequency and level, the state of the RF output and
the modulator and the kind of used frequency reference.
The buttons with the instrument's symbolic name on it provides access to
menus and dialogs for further instrument configuration. Refer to the User
Manual for a detailed description of all parameters and functions provided for
configuration.

A detailed description of the R&S SGMA-GUI, in depth information on how
to work with the application and on how to operate the R&S SGU and per-
form general configuration tasks is provided in the User Manual.

5.1.2 How to Use the Help System

The R&S SGMA-GUI is equipped with a context-sensitive help function. A help
page is available for each parameter and can be called any time during instru-
ment operation.

Compiled online help systems are also available on the CD-ROM supplied
with the instrument. This help program can be called on any controller with
Internet Explorer version V4.0 and higher.
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Calling context-sensitive and general help

► To display the general help dialog box, select the "SGMA-GUI > Help > Con-
tents" or use the F1 key.
The help dialog is displayed. A topic containing information about the current
menu or the currently opened dialog box and its function is displayed.

Contents of the help dialog box

The help dialog box contains two main areas:
● "Contents" - contains a table of help contents
● "Topic" - contains a specific help topic

The help system additionally provides an "Index" and a "Find" area, as well as
"Zoom" functions that are accessed by means of the corresponding buttons.

Navigating in the table of contents and in the help topics

1. To move through the displayed contents entries, use the mouse or the UP/
DOWN keys. Entries that contain further entries are marked with a plus sign.

2. To display a help topic, double click on the topic name or press the ENTER
key.

3. To jump to the linked topic, press the link text.

4. Use the "Previous" or "Next" links to jump to the corresponding topic.

Manual Operation via R&S SGMA-GUI
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5. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the
navigation window to the left or right.

Using the Index

1. Select "SGMA-GUI > Help > Index" or use the "Go to Index" button in the
"Help" display.

2. Enter the first characters of the topic you are interested in. The entries starting
with these characters are displayed.

3. Press the ENTER key to display the help topic.

The corresponding help topic is displayed.

5.2 Network and Remote Control Operation

As an alternative to operating the R&S SGU interactively via the R&S SGMA-GUI,
one can also controll the R&S SGU using programmed commands from a remote
PC.

The description in this section requires basic knowledge of the remote con-
trol operation. Definitions specified in the SCPI standard are not provided.
Nevertheless, you will find some basic information to the SCPI syntax, com-
mand lists, and general programming recommendations in section Remote
Control Basics of the User Manual. In addition, this chapter provides infor-
mation on the status reporting system of the instrument.

5.2.1 Remote Control Interfaces and Protocols

The instrument supports several interfaces for remote control. The following table
gives an overview.
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Table 5-1: Remote control interfaces and protocols

Interface Protocols Remarks

Local
Area Net-
work
(LAN)

● HiSLIP High-Speed LAN Instrument Proto-
col (IVI-6.1)

● VXI-11
● socket communication (Raw Ethernet,

simple Telnet)

A LAN connector is located on the
rear panel of the instrument.
The interface is based on TCP/IP
and supports various protocols.
For details see chapter 5.2.1.1,
"LAN Interface", on page 42

USB USBTMC A USB connector is located on the
rear panel of the instrument.
For details see chapter 5.2.1.2,
"USB Interface", on page 46

PCIe Proprietary A PCIe connector is located on
the rear panel of the instrument.
For details see chapter 5.2.1.3,
"PCI Express Interface",
on page 46

SCPI (Standard Commands for Programmable Instruments)

SCPI commands are used for remote control. Commands that are not taken from
the SCPI standard follow the SCPI syntax rules. The instrument supports the
SCPI version 1999. The SCPI standard is based on standard IEEE 488.2 and
aims at the standardization of device-specific commands, error handling and the
status registers. The tutorial "Automatic Measurement Control - A tutorial on SCPI
and IEEE 488.2" from John M. Pieper (R&S order number 0002.3536.00) offers
detailed information on concepts and definitions of SCPI.

5.2.1.1 LAN Interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, con-
sisting of a connector, a network interface card and protocols.

For remote control via a network, the PC and the instrument must be connected
via the LAN interface to a common network with TCP/IP network protocol. They
are connected using an RJ45 cable (shielded or unshielded twisted pair category
5). The TCP/IP network protocol and the associated network services are precon-
figured on the instrument. Software for instrument control and (for specified proto-
cols only) the VISA program library must be installed on the controller.
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Identifying instruments in a network
If several instruments are connected to the network, each instrument has its
own IP address and associated resource string. The controller identifies
these instruments by means of the resource string.

VISA Resource Strings

The VISA resource string is required to establish a communication session
between the controller and the instrument in a LAN. The resource string is a
unique identifier, composed of the specific IP address of the instrument and some
network and VISA specific keywords.

TCPIP::host address[::LAN device name][::INSTR]
● TCPIP designates the network protocol used
● host address is the IP address or host name of the device
● [::LAN device name] defines the protocol and the instance number of a sub-

instrument:
● [::INSTR] indicates the instrument resource class (optional)

The IP address (host address/computer name) is used by the programs to iden-
tify and control the instrument. It is automatically assigned by the DHCP server
the first time the device is registered on the network. Alternatively, you can also
assign its LAN device name.

You can find the IP address in the "SGMA-GUI > Instrument Name > Setup >
Remote" dialog, and also adjust it manually, if required.

See below the characteristics of the VISA resource strings for the corresponding
interface protocols. The highlighted characters are crucial.

HiSLIP

TCPIP::host address::hislip0[::INSTR]
● hislip0 HiSLIP device name, designates that the interface protocol HiSLIP is

used (mandatory)

hislip0 is composed of [::HiSLIP device name[,HiSLIP port]] and must be
assigned.

For details of the HiSLIP protocol, refer to "HiSLIP Protocol" on page 44.
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VXI-11

TCPIP::host address[::inst0][::INSTR]
● [::inst0] LAN device name, indicates that the VXI-11 protocol is used

(optional)

inst0 currently selects the VXI-11 protocol by default and can be omitted.

For details of the VXI-11 protocol, refer to ."VXI-11 Protocol" on page 45

Socket Communication

TCPIP::host address::port::SOCKET
● port determines the used port number
● SOCKET indicates the raw network socket resource class

Socket communication requires the specification of the port (commonly referred
to as port number) and of "SOCKET" to complete the VISA resource string with
the associated protocol used.

The registered port for socket communication is port 5025.

See also "Socket Communication" on page 45.

Example: 
● Instrument has the IP address 10.113.11.91; the valid resource string using

VXI-11 protocol is:
TCPIP::10.113.11.91::INSTR

● The DNS host name name is rssgu100a100021; the valid resource string is:
TCPIP::rssgu100a100021::hislip0 (HiSLIP)
TCPIP::rssgu100a100021::inst0 (VXI-11)

● A raw socket connection can be established using:
TCPIP::10.113.11.91::5025::SOCKET

HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for
VXI-11 for TCP-based instruments specified by the IVI foundation. The protocol
uses two TCP sockets for a single connection - one for fast data transfer, the
other for non-sequential control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

● High performance as with raw socket network connections
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● Compatible IEEE 488.2 support for Message Exchange Protocol, Device
Clear, Serial Poll, Remote/Local, Trigger, and Service Request

● Uses a single IANA registered port (4880), which simplifies the configuration
of firewalls

● Supports simultaneous access of multiple users by providing versatile locking
mechanisms

● Usable for IPv6 or IPv4 networks

Note that HiSLIP data is sent to the device using the "fire and forget"
method with immediate return, as opposed to VXI-11, where each operation
is blocked until a VXI-11 device handshake returns. Thus, a successful
return of a VISA operation such as viWrite() does not guarantee that the
instrument has finished or started the requested command, but is delivered
to the TCP/IP buffers.

For more information see also the application note: 1MA208: Fast Remote Instru-
ment Control with HiSLIP.

VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing
Remote Procedure Call) protocol which in turn relies on TCP/IP as the network/
transport layer. The TCP/IP network protocol and the associated network services
are preconfigured. TCP/IP ensures connection-oriented communication, where
the order of the exchanged messages is adhered to and interrupted links are
identified. With this protocol, messages cannot be lost.

Socket Communication

An alternative way for remote control of the software is to establish a simple net-
work communication using sockets. The socket communication, also referred to
as “Raw Ethernet communication”, does not necessary require a VISA installation
on the remote controller side.

The simplest way to establish socket communication is to use the built-in telnet
program. The telnet program is part of every operating system and supports com-
munication with the software on a command-by-command basis.

Socket connections are established on a specially defined port. The socket
address is a combination of the IP address or the host name of the instrument
and the number of the port configured for remote-control. All instruments use port

Network and Remote Control Operation
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number 5025 for this purpose. The port is configured for communication on a
command-to-command basis and for remote control from a program running on a
connected PC.

5.2.1.2 USB Interface

For remote control via USB connection, the PC and the instrument must be con-
nected via the USB interface. A USB connection requires the VISA library to be
installed. VISA detects and configures the R&S instrument automatically when
the USB connection is established. You do not have to install a separate driver.

You can retreive the USB resource string from the "SGMA-GUI > Instrument
Name > Setup > Remote" dialog.

Example: 
USB::0x0AAD::0x00ce::100021::INSTR
0x0AAD is the vendor ID for Rohde&Schwarz
0x00ce is the product ID for the R&S SGU
100021 is the serial number of the particular instrument

5.2.1.3 PCI Express Interface

A PCI Express (PCIe) connector is provided on the rear panel of the instrument.

Refer to chapter "Advanced Remote Control via PCIe" of the User Manual the for
a description of how to set up a remote control connection via PCIe and the per-
mitted cables.

Via PCI Express some commands can be sent to the instrument with optimized
speed (memory-mapped remote control), e.g. frequency or level settings. This
allows minimum setup time.

You can retreive the PCIe resource string from the "SGMA-GUI > Instrument
Name > Setup > Remote" dialog.

Example: 
PCIe::0x162f::0x132e::100021::INSTR
0x162f is the vendor ID for Rohde&Schwarz
0x132e is the product ID for the R&S SGU
100021 is the serial number of the particular instrument
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Using the PCIe interface for remote control of the instrument requires
extended knowledge and is described in section "Advanced Remote Con-
trol via PCIe" in the User Manual.

5.2.2 Example: Remote Control over LAN using the VXI-11 Pro-
tocol

In the following example, the program "Measurement & Automation Explorer"
from National Instruments is used on a Windows operating system to set up a
LAN remote control link and to start a remote control session. The remote control
program "Measurement & Automation Explorer" opens the connection to the
instrument (using VISA functionality) and then sends commands to and receives
device responses from the instrument.

A remote control connection requires a VISA installation but no additional hard-
ware on the controller PC. The LAN I/O channel is selected at initialization time
using the VISA resource string (also referred to as "address string"). A VISA alias
(short name) is generally used to replace the complete resource string. The host
address is either the R&S SGU's computer name or its IP address.

Proceed as described in chapter 2.3.2.2, "Assigning the IP Address", on page 20
to determine the relevant address information.

In this example, it is assumed that:
● a LAN remote control link between the controller and the R&S SGU is

already set up.
For information on setting up the link see chapter 2.3.2, "Connecting a
Remote PC via LAN", on page 19.

● a VISA and the "Measurement & Automation Explorer" program are
installed on the remote PC.
For detailed information, refer to section "Remote Control Basics" in the
User Manual or to the online help of the "Measurement & Automation
Explorer" program.
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To configure the controller

The instrument is preconfigured for networks using DHCP (dynamic host
configuration protocol). If this configuration is used, enter the computer
name in the position of the IP address.

To enable the external controller to communicate with the software via TCP/IP
protocol, set up a remote control link as follows:

1. Connect the controller and the instrument to the network (network cable) and
switch them on.

2. Start the 'Measurement & Automation Control' program on the controller.

3. Select "Devices and Interfaces > Create New".

4. Select "VISA TCP/IP Resource" and confirm with "Next".

5. Choose the type of TCP/IP resource you wish to add and select "Next".
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6. Enter the IP address or the host name of the R&S SGU and select "Next".

7. Enter the alias name if required.
The alias name must not be mistaken for the computer name. It is only used
for instrument identification within the program and displayed in the menu as
an option in case of an Ethernet link.

8. Confirm the settings with "Finish".
The instrument is configured and the settings are displayed in the "TCP/IP
Settings" tab.

9. To test the connection, select "Validate".
A message indicates whether the link to the instrument can be set up or not.
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If a connection cannot be set up, check whether the controller and the instru-
ment are connected to the network (network cable) and are switched on. Cor-
rect spelling of the IP address or the computer name should be checked. For
further error location, inform the network administrator. In large networks,
specification of additional addresses may be required for link setup, e.g. gate-
way and subnet mask, which are known to the network administrator.

The instrument is now registered in the program and can be addressed via the
resource string or alias name.

To start a remote control session over LAN (using VXI-11)

1. Start the "Measurement & Automation Explorer" on the controller.

2. In the "Configuration" window, select "Device and Interfaces > VISA TCP/IP
Resources", select the required instrument and select "Open VISA Test
Panel".

3. In the "viWrite" tab, write the command to be sent to the instrument and select
"Execute".
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Instrument responses are displayed on the "viRead" tab.
Tip: For further program operation refer to the online help of the program.

Network and Remote Control Operation
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